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About This Guide

Welcome to the A/UX operating system on your Apple Macintosh computer. A/UX
brings the Macintosh interface to the traditional UNIX® operating system environment. It
weds Macintosh ease of use to UNIX standards, power, and programmability.

This book, A/UX Essentials, presents the basic skills you need in order to use A/UX.
Many of the chapters contain tutorials to help you learn the essential techniques and
concepts. You can read through this guide in sequence or go directly to the information
you need. However, if you are unfamiliar with A/UX; you should go through the first five
chapters before proceeding on your own.

This Preface contains the following sections:
s Whatis A/UX?

= Who should use this guide

= How to use A/UX Essentials

= Conventions used in this guide

What is A/UX?

A/UX brings together two outstanding computing environments: UNIX and the
Macintosh.



Why UNIX?

The UNIX operating system is important because it is a standards-compliant,
multitasking, multi-user operating system.

A standards-compliant system is one that complies with industry-wide standards
that allow it to function on a network with a wide variety of hardware and software.

A multitasking system is one that allows you to run many processes at the same
time. Thus, instead of having to wait while your computer prints a textfile, you can work
on another project while the printing is in progress.

A multi-user system is one that allows many users to work on the same system at
the same time. This enables them to share files and information.

The basic A/UX operating system is a combination of UNIX systems
(AT&T System V.2 and extensions from BSD 4.2 and 4.3).

Why the Macintosh interface?

A/UX enhances the UNIX operating system with the Macintosh Finder interface. This
enhancement differentiates A/UX from all other versions of UNIX. With A/UX you can
perform the following tasks:

= Use menu commands and manipulate icons to open, move, rename, or copy files
and applications on the A/UX and the Macintosh file systems concurrently.

= Store Macintosh files and applications in the A/UX file system as well as in the
Macintosh file system. For further information on file systems, see “Introducing
A/UX” in Chapter 1, “Starting and Finishing a Work Session.”

= Use the Macintosh files or off-the-shelf Macintosh applications while running

A/UX exactly as you use them while running the Macintosh Operating System
(Macintosh OS).

= Run several applications at the same time, taking advantage of both Macintosh
features and A/UX multitasking capabilities. This applies to both A/UX and
Macintosh applications in any combination.

xxii  Preface



N

Two operating systems on one personal computer

A/UX allows you to run Macintosh software applications while using UNIX. Furthermore,
you can do so while UNIX processes are running.

As shipped, A/UX sets aside a small area on your disk for the Macintosh OS. It is from
this area (called MacPartition) that A/UX is launched. It is important to remember that
you do not need to run your Macintosh applications from this area. You can store your
Macintosh applications, as well as your Macintosh files, among your UNIX files. This
gives you the advantage of using UNIX file access permissions and UNIX utilities, such as
backup tools and file-search utilities, on your Macintosh files.

In addition, while running A/UX you can use floppy disks configured for the
Macintosh. You can also use additional hard disks containing the Macintosh file system.

Thus, you can take advantage of both operating systems at the same time.

Commando, a command-building tool

In addition to bringing the Finder’s ease of use to the capabilities of UNIX, A/UX also
adds dialog boxes for running the more than 500 UNIX commands available in A/UX.
This means that you can now use the many options and utilities that UNIX and A/UX
make available without having to learn the complex commands and options themselves.
Each dialog box allows you to use the mouse to select the options.

Commando is described in full in Chapter 4, “Using UNIX Commands and
Commando.”

Who should use this guide

A/UX Essentials contains information that is important to anyone who plans to use

A/UX. It presents concise tutorials that introduce you to the Macintosh way of interacting
with the traditional UNIX environment and that briefly explain the uses of essential parts
of A/UX.

About This Guide — xxiii
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Preface

Although everyone who uses A/UX should consult A/UX Essentials to become
familiar with A/UX, this guide is designed particularly for users who are not experienced
with A/UX or other versions of UNIX. It will also prove useful to those who are
somewhat new to the Macintosh computer, although this guide assumes that you are
already familiar with basic Macintosh skills. You should be sure to read Macintosh User’s
Guide: Essentials and to follow the tour disk, Macintosh Basics.

The road map diagram, just before the beginning of the Table of Contents, illustrates
the learning path for A/UX .

How to use A/UX Essentials

This guide is an introduction to A/UX. You should read at least the first five chapters and
work through the tutorials in those chapters. Once you are comfortable with the basics
of A/UX, you can use this book as a reference work.

Users who are familiar with the UNIX operating system and the UNIX command-line
interface, but who are new to the Macintosh, should read Chapter 2 carefully (“Using
Files, Folders, and Directories”) to accustom themselves to the Macintosh-like features of
the Finder. They should also note the flexibility and ease of manipulating CommandShell
windows (discussed in Chapter 3, “Using CommandShell”), the extent to which
Commando can simplify the use of UNIX commands (discussed in Chapter 4, “Using
UNIX Commands and Commando”), and the easy-to-use UNIX Permissions dialog box
(discussed in Chapter 5, “Permissions”).

Users who are unfamiliar with UNIX should go through the tutorials in Chapters 3, 4,
and 5 if there is any likelihood that they will have to use UNIX commands or adjust UNIX
permissions.

What's in this guide

This guide deals with the basics of learning and using A/UX on your Macintosh.
However, there are many situations that require more specialized information than is
covered here. The list of topics and references in Table P-1 will tell you where to turn for
further information.



A/UX Essentials contains the following chapters:

»  Chapter 1, “Starting and Finishing a Work Session,” teaches you how to start the
system, log in, and log out. Chapter 1 also introduces other skills and information
essential to getting started.

»  Chapter 2, “Using Files, Folders, and Directories,” teaches you how to maneuver
within the A/UX file hierarchy and use files and folders. It also introduces you to
UNIX-style pathnames.

= Chapter 3, “Using CommandShell,” shows you how to use CommandShell windows,
which provide the UNIX command-line interface. This allows you to work directly
with the A/UX operating system using traditional UNIX commands.

= Chapter 4, “Using UNIX Commands and Commando,” describes a major innovation
of A/UX, Commando, which allows you to run UNIX commands with Macintosh-like
dialog boxes. It also introduces the basic concepts of using UNIX commands.

~

= Chapter 5, “Permissions,” introduces UNIX permissions and teaches you how to
check them and change them.

»  Chapter 6, “Writing With TextEditor,” introduces you to the Macintosh-style text
editor, which allows you to create and edit text-only files using the Macintosh menus
and a mouse.

»  Chapter 7, “Printing,” describes the different kinds of printer connections and the
various ways of sending a file to the printer while using A/UX.

= Chapter 8, “Customizing Your Work Environment,” explains how to use various
devices to create precisely the work environment that you need.

= Chapter 9, “A/UX Reference,” presents a brief summary of all menus and menu
commands in the A/UX Finder, CommandShell, and TextEditor.

»  Chapter 10, “Troubleshooting,” shows how to solve some problems that can arise
while you are using A/UX.

»  Chapter 11, “Where to Go From Here,” gives you information on resources available
for learning more about A/UX.

»  The Glossary contains definitions of all A/UX terms introduced in this guide.

For other information about A/UX, you will want to refer to other manuals about the
operating system. Table P-1 suggests topics you may need to know about and lists the
books in which you will find the information.
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Preface

Table P-1 Finding further information

Topic Book

Setting up and using a network A/UX Networking Essentials; A/UX Networkiig System
Administration

Setting up a printer for one computer Setting Up Accounts and Peripherals for A/UX

Setting up a printer fora network A/UX Networking Essentials

Creating a user account Setting Up Accounts and Peripherals for A/UX

Backing up your entire system A/UX Local System Administration

Setting a password for the A/UX Startup ~ A/UX Installation Guide
application

Terminology: UNIX-style and Macintosh-style

Although A/UX links the UNIX and Macintosh environments, these two environments
use different terminology. For example, Macintosh users are familiar with the word
“folder.” It represents essentially what UNIX users call a “directory.” The term “folder” is
particularly meaningful when you are using the Finder, where it is represented by a file-
folder icon. In the UNIX environment, however, the term “directory” is more useful.
Therefore, when you are entering commands in a CommandShell window, it’s best to
think in terms of a directory rather than a folder, especially when you are entering such
commands as “make directory” (mkdir) or “change directory” (cd).

For that reason, this guide uses Macintosh terminology when describing how to work
with the Finder and UNIX terminology when describing operations performed in a
CommandShell window.

Conventions used in this guide

A/UX guides follow specific conventions. For example, words that require special
emphasis appear in specific fonts or font styles. The following sections describe the
conventions used in all A/UX guides.



Keys and key combinations

Certain keys on the keyboard have special names. These modifier and character keys,
often used in combination with other keys, perform various functions. In this guide, the

names of these keys are in Initial Capital letters followed by SMALL cAPITAL letters.

The key names are

Caprs Lock DowN ArroW () OPTION SPACE BAk
CoMMAND (% ) ENTER RETURN TaB

CONTROL ESCAPE RIGHT ARROW (—) Upr Arrow (T)
DELETE LEFT ARROW () SHIFT

Sometimes you will see two or more names joined by hyphens. The hyphens
indicate that you use two or more keys together to perform a specific function. For
example,

Press COMMAND-K

means “Hold down the Commann key and then press the K key.”

Terminology

In A/UX guides, a certain term can represent a specific set of actions. For example, the
word enter indicates that you type a series of characters on the command line and press

the ReTury key. The instruction
Enter 1s

means “Type 1s and press the RETURN key.”

Here is a list of common terms and the corresponding actions you take.
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Term Action

Click Press and then immediately release the mouse button.

Drag Position the mouse pointer, press and hold down the mouse button
while moving the mouse, and then release the mouse button.

Choose Activate a command in a menu. To choose a command from a pull-
down menu, position the pointer on the menu title and hold down the
mouse button. While holding down the mouse button, drag down
through the menu until the command you want is highlighted. Then
release the mouse button.

Select Highlight a selectable object by positioning the mouse pointer on the
object and clicking.

Type Type a series of characters without pressing the RETURN key.

Enter Type the series of characters indicated and press the RETURN key.

The courier font

Throughout A/UX guides, words that appear on the screen or that you must type exactly
asshownare inthe Courier font

For example, suppose you see this instruction:

Type date onthe command line and press RETURN.
The word date isinthe Courier font to indicate that you must type it.
Suppose you then read this explanation:

After you press RETURN, information such as this appears on the screen:
Tues Oct 17 17:04:00 PDT 1989

Inthis case, Courier isusedto represent the text that appears on the screen.

All A/UX manual page names are also shown inthe Courier font. For example,
the entry 1s(1) indicates that 1s is the name of a manual page in an A/UX reference
manual. See “Manual Page Reference Notation,” later in this preface for more information
on the A/UX command reference manuals.
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Font styles

Italics are used to indicate that a word or set of words is a placeholder for part of a
command. For example,

cat filename

tells you that filename is a placeholder for the name of a file you want to display. For
example, if you wanted to display the contents of a file named E1vis, you would type
the word Elvis in place of filename. In other words, you would enter

cat Elvis

New terms appear in boldface where they are defined. Boldface is also used for
steps in a series of instructions.

A/UX command syntax

A/UX commands follow a specific command syntax. A typical A/UX command gives the
command name first, followed by options and arguments. For example, here is the
syntax for the wc command:

we [-1] [-w] [-c] [filename]..

In this example, wc isthe command, -1, -w,and -c are optionsand filename
is an argument. Brackets ([ ]) enclose elements that are not necessary for the command
to execute. The ellipsis (...) indicates that you can specify more than one argument.
Brackets and ellipses are not to be typed. Also, note that each command element is
separated from the next element by a space.

The following table gives more information about the elements of an A/UX
command.
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Element Description

command The command name.

option A character or group of characters that modifies the command. Most
options have the form - option, where option is a letter representing an
option. Most commands have one or more options.

argument A modification or specification of a command, usually a filename or
symbols representing one or more filenames.

[] Brackets used to enclose an optional item—that is, an item that is not
essential for execution of the command.

Ellipses are used to indicate that you can enter more than one
argument.

For example, the wc command is used to count lines, words, and characters in a
file. Thus, you can enter

wCc -w Priscilla

In this command line, -w is the option that instructs the command to count all of the
words in the file, and the argument Priscilla is the file to be searched.

Manual page reference notation

The A/UX Command Reference, the A/UX Pregrammer’s Reference, the A/UX System
Administrator’s Reference, the X11 Command Reference for A/UX, and the X11
Programmer’s Reference for A/UX contain descriptions of commands, subroutines, and
other related information. Such descriptions are known as manual pages (often
shortened to man pages). Manual pages are organized within these references hy section
numbers. The standard A/UX cross-reference notation is

command (section)

where command is the name of the command, file, or other facility; and section is the
number of the section in which the item resides.



= Jtems followed by section numbers (1IM) and (8) are described in the A/UX System
Administrator’s Reference.

= [tems followed by section numbers (1) and (6) are described in the A/UX Command
Reference.

= Ttems followed by section numbers (2), (3), (4), and (5) are described in
the A/UX Programmer's Reference.

= [tems followed by section number (1X) are described in the X711 Command
Reference for A/UX.

= Jtems followed by section numbers (3X) and (3Xt) are described in theX71
Programmer’s Reference for A/UX.

For example

cat (1)
refers to the command cat, which is described in Section 1 of the A/UX Command
Reference.

You can display manual pages on the screen by using the man command. For
example, you could enter the command

man cat
to display the manual page for the cat command, including its description, syntax,
options, and other pertinent information. To exit a manual page, press the SPACE Bar

until you see a command prompt, or type g atany time to return immediately to your
command prompt.

For more information

To find out where you need to go for more information about how to use A/UX, see
Road Map to A/UX. This guide contains descriptions of each A/UX guide and ordering
information for all the guides in the A/UX documentation suite.
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1 Starting and Finishing a
Work Session

This chapter introduces you to A/UX; it then explains how to start and end a work
session and what to do when you're ready to quit working for the time being. It also

explains how to shut down the computer. Chapter 1 covers the following topics:

s Introducing A/UX

= Starting the computer

»  Starting A/UX

s Loggingin

= You're ready to work

= What are you allowed to do?
= Logging out

= Shutting down A/UX

= About system administration

Although this chapter is designed to be read in sequence, you can also use it as a

reference work by going directly to the section that contains the material you need.



Introducing A/UX

1-2

A/UX joins two systems that have different histories and different styles of operation, but
that now work together. They are the UNIX® operating system (in Apple Computer’s
version, called A/UX) and the Macintosh Finder, which is familiar to all those who have
used the Apple Macintosh computer. In practical terms, this means that you are using the
UNIX operating system through the Macintosh user interface. This allows you to use
Macintosh icons and mouse operations to manipulate the commands and utilities that
give UNIX its flexibility and power.

Although this guide speaks of using A/UX instead of the Macintosh Operating System
(OS), in fact, there is one area of your startup disk, called MacPartition, that contains the
Macintosh OS. This is used to start the computer and to give the computer the command
to load and launch A/UX. MacPartition contains a Macintosh file system, the files on the
rest of the disk are contained in one or more UNIX file systems.

While you are running A/UX, the Finder allows you to open files and folders, close
them, copy them, and move them, and to perform a variety of other functions as well.
You can use the Finder to manipulate all files and folders that you have permission to
manipulate (UNIX permissions are discussed in Chapter 5, “Permissions”). This is true
whether they are stored in a UNIX file system or in the Macintosh file system.

In summary, A/UX offers you three distinct environments:

= The A/UX Finder, which provides access to both your UNIX and your Macintosh file
systems.

= The Macintosh OS, which provides access only to files and folders that are in
MacPartition or in a Macintosh file system on some other disk. Files and folders
contained in a UNIX file system are not visible from the Macintosh OS Finder.
Chapter 2 contains a section that tells you how to turn on the Macintosh OS (“Getting
to the Macintosh OS”).

= CommandShell (a UNIX command-line interface) provides access only to UNIX file
systems. CommandShell cannot work with any material stored in a Macintosh file
system, such as MacPartition.
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Starting the computer

Before you start the computer, you or the system administrator should set up your
hardware according to the instructions that were packaged with it, install A/UX by
following the directions in the A/UX Installation Guide. Consult Setting Up Accounts and
Peripherals for A/UX for connecting and setting up peripheral devices such as printers.

Turn on the computer as follows:

m  Press the Power ON key.

The Power ON key is the key with a small triangle. It is at the top of the keyboard, either
in the middle or in the right corner. The Macintosh SE/30 has its power switch on the
back of the computer.

T
r/ \

/

.-\ POWERON key /-
Y '

S
ETIIN

R BN
LS O TS

SR

The computer starts up and displays the message Welcome to Macintosh, which
indicates that the computer is starting the Macintosh OS. A/UX will be launched from the
Macintosh OS. Proceed to “Starting A/UX.”
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Starting A/UX

1-4

There are two ways to start A/UX:

= Automatically, by presetting your system so that the A/UX Startup application
launches as soon as the computer begins to run the Macintosh OS

= Manually, by following the directions in “Starting A/UX Manually”

If A/UX is set to start automatically, the system loads and launches A/UX now. If your
system launches in this way, continue with “Loading and Launching,” later in this
chapter.

A/UX does not start up automatically unless you or the system administrator have set
it to start automatically. Although the installation instructions advise setting automatic
startup, your system can be set for manual startup of A/UX.

If you wish to set your system to start A/UX automatically, proceed to the next
section, “Setting Automatic A/UX Startup.”

If your system is not set to start A/UX automatically and you wish to start A/UX
manually, proceed to “Starting A/UX Manually,” later in this chapter.

Setting automatic A/UX startup

If your system is not set to start A/UX automatically, you can set it to do so after the
MacPartition disk icon is displayed (Figure 1-1), and before you start A/UX manually.

L1

MacPartition

Figure 1-1 The MacPartition icon

Follow these steps:

Position the mouse pointer in the Control Panels icon of the Apple (&) menu
and release the mouse button to display the Control Panels window.
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=i
18 items 52.4 MB in disk 22.5 MB available
— ki
a [t
5 ¢ R
—O = =0
Celer Easy Access Memory File Sharing Monitor
o | i
leneral Controls Keyboard Labels MacTCP Map
"y [l &
ﬂ . =il ﬂ ﬂ’))
=0 O 5 0
Monitors Mouse Network  Sharing Setup Sound
-]
=
HiE =
Startup Disk Users & Groups  Views -
M
|

Startup Disk control panel icon

2 Doubleclick the Startup Disk control panel icon.

The following window appears.

E[J=— Startup Disk ———=
Select a Startup Disk:
s
) [
[acPartition Extra Mac Disk
<]

3 Click on the MacPartition icon to select it and click the close box to close the
control panel.

Double-click the MacPartition icon (at the right edge of the screen) to display
the MacPartition window,, if it is not already displayed.

The MacPartition icon is shown in Figure 1-1.
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Create an alias of the A/UX Startup application by clicking the A/UX Startup
icon in the MacPartition window and choosing Make Alias from the File menu.

A duplicate of the A/UX Startup application icon appears beside the original, with the
name A/UX Startup alias.

=E[[==—————= Mac Partition EEEI
8items 2.5 MB in disk 1.3 MB available

= 3
] %3 .m

System Folder bin A/UK Startup FY,

=3 [
rj:l
qﬁ% <:aT‘u‘x

boot_cd asch

launch

Open the System Folder icon in the MacPartition window by double-clicking
its icon.

EJ=——— System Folder =——r—F

11 items 2.7 MB in disk 1.1 MB available

=Y

Apple Menu tems Extensions Clipboard Control Panels Finder

Preferences System Scrapbook File Startup Items

O
<] 0

Drag the A/UX Startup alias icon to the Startup Items icon to place it in the
Startup Items folder.

Close the System Folder by clicking its close box.

The next time you start the computer, the process described later in this chapter, in
“Loading and Launching,” starts automatically.

For further information on setting automatic A/UX startup, see A/UX Local System
Administration.
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Starting A/UX manually
If A/UX is not set to start automatically, you must start A/UX by running the A/UX

Startup application manually. Follow these steps to start up A/UX manually:

Double-click the MacPartition icon, which is located at the right edge of the
screen. The MacPartition icon is shown in Figure 1-1.

The A/UX Startup icon appears in the MacPartition disk window.

E[1=———= MacPartition =—-"15
& items 1.4 MB in disk 2.4 ME available
«J s
a= | |
AsUX g
System Folder bin & /UK Startup
A
e L]

A/UX Startup icon

Double-click the A/UX Startup icon to launch A/UX.

A/UX begins the loading and launching process.

Loading and launching

As the A/UX Startup program runs, a series of screens appears to inform you of its
progress. One of these screens is shown in Figure 1-2.

The A/UX Startup application checks the condition of the file systems each time you
start A/UX and fixes problems identified during the check. For example, problems can
be caused if the system was shut down improperly the last time it was used. This check
can last for several minutes.

Cf‘qrj—%l Welcome to A/UH.
AsuR Checking root file system...

| | Messages

Figure 1-2 A startup status screen

Starting A/UX 1-7



& Note During the loading and launching process, the screen might flicker or even
become blank fora moment. However, the progress bar reappears quickly and the
process continues. &

The Cancel and Messages buttons in the Startup screen

When the startup process begins, a Cancel button is available at the right of the progress
bar (shown in Figure 1-2). You can cancel the Startup program by clicking the Cancel
button.

The Cancel button changes to a Messages button after a few seconds. If you click the
Messages button, a small window appears that displays status messages describing the
progress of the startup process. If you are a nontechnical user, you probably will not use
this feature.

Important A/UX might report alert messages during the startup sequence. In some
cases, you must supply information in response to the message. If this happens, an alert
box appears and tells you that there is a message for you. When you click OK in the alert
box, an A/UX System Console window appears, into which you can enter any
information that the program requests. For further information on the A/UX System
Console window, see “Using the A/UX System Console” in Chapter 3, “Using
CommandShell.”

At the end of the startup process, the Login dialog box appears. Proceed with the
next section,Logging In,” to learn about logging in to different accounts in A/UX,

Logging in

Unlike the Macintosh OS, A/UX supports many users on a single computer. Therefore,
you must identify yourself to the system before you can be permitted to use it. This
procedure is called logging in.
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User accounts and home directories

The terms user account and home directory (or home directory folder) appear
frequently in A/UX manuals, as they do in the documentation of all UNIX systems. A
brief discussion of these terms follows.

The user account

Just as you must have a bank account in order to use the services of a bank, so you must
have an account on an A/UX system before you can use A/UX. This allows you to
protect your files and information from being used by others, in the same way that your
bank account protects your deposits and information about your deposits from outsiders.
Your files are protected by a scheme of permissions that is discussed in detail in

Chapter 5, “Permissions.”

As shipped, A/UX contains a Guest account to which anyone canlog in, and a start
account which is used for tutorial purposes. In addition, your system administrator might
have created a user account that is meant for your personal use.

The start account and the Guest account can be used by several users, although your
system administrator might require use of a password to log in to those accounts in order
to limit the number of people who have access to them. For information on passwords,
see the information on logging in later in this chapter, and see “Changing Your
Password” in Chapter 8, “Customizing your Work Environment.”

If you are a regular user of the system, you should have your own user account. Your
system administrator assigns a login name (also called the user name and the user
account name) to you when he or she creates your user account. If you are acting as
your own system administrator, you can find instructions for creating a user account in
Setting Up Accounts and Peripherals for A/UX.

The home directory folder

Your login name is simply a designation that tells the system that you are a legitimate
user with an account. Your home directory folder, however, is an actual folder that
contains your own files. It is common practice to name the home directory folder with
the users login name. Whenever you log in to A/UX, an alias of your home directory
folder icon appears near the right edge of the screen. Figure 1-3 shows the alias of the
home directory folder for the start account.
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[

stardt alias

Figure 1-3 The home directory folder alias for the start account

An alias of a file or folder is an icon that is linked to the original file or folder so that it
can be manipulated like the original. However, you can put the alias in a different place
in the file hierarchy without moving the original file or folder. In addition, the alias is
usually normally given the name of the original file or folder plus the word alias. Since
the name of your home directory folder is likely to be your login name, the folder that
appears at the right edge of the screen is named with your login name plus alias, for
example, start alias.

If the folder has been moved to another part of the screen, it appears in its new
position when you next log in.

Your home directory folder is your home base on the computer while you are using
A/UX. Although you can spend as much time as you want away from home, your home
remains your headquarters and is probably the place where you keep most of your
belongings.

The phrase home directory folderis an adaptation of the standard UNIX term home
directory. What the UNIX world calls a directoryis called a folder in the Macintosh
world, and appears in the A/UX Finder with a folder icon. Therefore the name home
directory folder has been coined.

You can deny other users permission to add files to your home directory folder or to
remove files from it, and you also can control their ability to read or change any files that
you have created, whether or not these files are situated in your home directory folder.
For further information on these file- and folder-protection schemes, see Chapter 5,
“Permissions.”

Your login name

For purposes of your A/UX system, you are identified by the name under which you
logged in. Moreover, your login name determines the name of your home directory and
which files and folders you have permission to use.
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The Login dialog box

When you log in, you give the system two pieces of information:

= your login name

= your password

You can log in to any one of several types of accounts:
= the start account for tutorials

= the Guest account for guest users (if the system administrator has restricted access to
the start account)

= your own user account (if the system administrator has assigned you one)

= the root account for system administrators

This section describes how to log in to these accounts.
As soon as A/UX Startup finishes running, the Login dialog box appears. You can log
in whenever you see the Login dialog box, shown in Figure 1-4.

# Note Several login options are available while the Login dialog box is displayed.
These options include changing your password. If you are a new user, your system
administrator might have assigned you a temporary password with the understanding
that you would use the Change Password login option to choose your own password as
soon as possible. To do so, see “Changing Your Password,” in Chapter 8. Other login
options are also explained in Chapter 8; see “Changing Your Session Type.” o

|
(‘i“__‘%l Welcome to A/UH Startup.
R/UX
Log in as:
QO Guest
@ Registered User
Name: |ruot |
Password: ||
oon ]
A—

Figure 1-4 The Login dialog box
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To log in means to enter the name of the account you are about to use and to enter
the account’s password (if required). The three sections that follow describe how to log
in to the start account, the Guest account, and the user and root accounts. Refer to the
section of this chapter that describes how to log in to the account you want to use.

Important UNIX is case sensitive, that is, it distinguishes between uppercase and
lowercase letters. If your login name is supposed to be john, but you type John,
A/UX won't recognize it because of the uppercase J. This is true of all character
sequences that A/UX reads, such as commands, passwords, folder names, and so on.

Logging in for the tutorials

The start account contains the files associated with the various tutorials in this book. Log
in to this account whenever you use a tutorial presented in this guide.

Tolog in to the start account, follow these steps:

While the Login dialog box is displayed, click the Registered User button to
select it, unless it is already selected.

Type start asthe login name.

The login name for the tutorial account is start. Notice that all the letters in the name
start are lowercase. Remember to enter the login name exactly as specified, using
lowercase letters unless capital letters are indicated.

Press RETURN.

This action moves the cursor to the Password text box. You also can press Tas or click
the Password text box to move there. A/UX asks you fora password to ensure system
security. Each account has a password so that only the person who is entitled to use that
account has access to it.
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4 Type my.passwd or use the password given to you by the system
administrator.

Note that the period in my . passwd has no spaces before or after it.
A gray rectangle expands through the Password text box as you type each character.

Since the password my . passwd appears in this book, it’s a good idea to change this
password immediately, to prevent anyone from breaking into your system by using the
start account. Your system administrator might already have changed the password.

To change the password for your account, see “Changing Your Password,” in
Chapter 8, “Customizing your Work Environment.”

5 Click Login or press RETURN.

If the password and the login name are correct, you're logged in and the Finder appears
after a few moments. If you type the wrong login name or password, a warning dialog
box appears. Try again, and be sure that you are typing lowercase and uppercase letters
as required.

If you make a mistake while typing your login name or password, click the Name or the
Password field to select it; then press the DeLETE key.

Type the login name or password again and click Login or press RETURN.

Proceed to “You're Ready to Work,” later in this chapter.

Logging in to the Guest account

If your system administrator has not set up a user account for you, you can use the
Guest account.

To log in to the Guest account, follow these steps:

1 while the Login dialog box is displayed, click Guest.

The system administrator might have set up the system so that you do not need to enter
the Guest account password.
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= Ifyou aren't required to enter a password, the Password field does not appear when
you click the Guest radio button.

= Ifyou are required to enter a password, the Password field appears in the Login
dialog box. If you do not know the password, see your system administrator or the
person in charge of the Guest account.

2 Ifa password is required, type the password.

3 Click Login or press RETURN.

See “Changing Your Password” in Chapter 8, “Customizing Your Work Environment,” for
more information on security and passwords.

If you make a mistake while typing your password, click the Password field to select it;
then press the DeLETE key. Type the password again and click Login or press RETURN.

If the password is correct, you're logged in and the Finder appears after a few moments.
Proceed to “You're Ready to Work,” later in this chapter.

Logging in to your user account or the root account

Your personalized user account allows you full use of the files that you create. It also
contains files that specify preferences about your work habits, such as the pattern of
your desktop. Your system administrator has set up the account by using the adduser
script described in Setting Up Accounts and Peripherals for A/UX or by following
standard UNIX procedures for setting up a user account. You should log in to this
account whenever you're working with A/UX, except when using the tutorials in this
book, in which case you should log in to the start account.

If you are authorized to have access to all files in the file system in order to perform
system maintenance and system administration tasks, and if you know the password for
the root account, you also can use these instructions to log in to the root account.
Substitute the name root foryour user name.
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To log in to your user account or the root account, follow these steps:

While the Login dialog box is displayed, click the Registered User button, unless
it is already selected.

Type your login name.

If you are logging in to the root account, type root. If you are logging in to a user
account, type the login name assigned to you by your system administrator. Remember
to enter the login name exactly as specified, using lowercase letters unless uppercase
letters are indicated.

Press RETURN.

This action moves the cursor to the Password text box. You also can press Tas or click
the Password text box to move the cursor there. A/UX asks you for a password to ensure
system security. Each user account has its own password. To change your account
password, see “Changing Your Password,” in Chapter 8, “Customizing Your Work
Environment.”

If the system administrator created your user account without assigning a password, you
might be asked to assign your own password by typing it into the space provided.

Type your password.

A gray rectangle expands through the Password text box as you enter each character.

Click Login or press RETURN.

If you make a mistake while typing your login name or password, click the Name or
Password field to select it; then press the DELETE key.

Type the login name or password again and click Login or press RETURN.

If the password and the login name are correct, you're logged in and the Finder appears
after a few moments. Proceed to the section called “You're Ready to Work.”

loggingin  1-15



You're ready to work

The Finder now appears, as shown in Figure 1-5. This is a special application that
manages the desktop. It displays icons that represent the available UNIX and Macintosh
file systems. The Finder makes it easy to work with disks and many types of files, such as
text files, programs, and utilities. Use the Finder to open a folder or a file or to execute a
program by double-clicking its icon.

If you started A/UX manually, by opening the MacPartition folder and double-
clicking the A/UX Startup icon, the MacPartition folder might still be open. You can close
it by clicking the close box at the upper left of the MacPartition window. If your system
starts A/UX automatically, the MacPartition folder is probably not open when the Finder

appears.
& File Edit e
A/UXfile
hierarchy icon
Home directory
folder

A second Macintosh
hard disk
MacPartition

icon

Figure 1-5 The A/UX Finder
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The Secure Startup feature

If the MacPartition icon does not appear in your Finder, it means that your system
administrator has activated a feature called Secure Startup. This is a security feature that
prevents users from opening the MacPartition window. If Secure Startup is running, your
system launches A/UX automatically; you do not need to open MacPartition to launch it.
Only users logged in to the root account can see and open MacPartition.

For further information on Secure Startup, see A/UX Installation Guide.

Locating the start folder

If your system administrator has set up a user account for you, an alias of your home
directory folder, labeled with your login name and the word alias, appears near the right
edge of your screen. If you logged into the start account (or the Guest account), the start
(or Guest) folder is your home directory folder.

& Note If others have used your system before you, you can see the same windows
that were displayed when the previous user logged out. It's possible, therefore, that a
window is covering the icon for your home directory folder. If so, you can move some of
the windows to find the icon. e

If you are not logged in to the start account, but you want to use the start folder
for the tutorials in this book, locate the start folder as follows:

Double-click the UNIX file hierarchy icon, at the upper right of the screen.

This is the disk icon with the slash (/) label. This action opens the / folder, which is at
the top of the UNIX file system. The icon is called either the UNIX file hierarchy icon or
the slash (/) folder icon.

L]
/
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2 Double-click the folder labeled users.

Both the start and the Guest folders are now visible. Other users’ home directory folders

also can be located here.

/
'RZZ items 56.5 MB in disk 10.8 MB available
CEZZIaN CEZZIaN
®profile FILES bin dev etc lib
o O O o I
lost+found mnt newunix nextunix root shlib
[ ]
tmp unix usr
users =
_ﬁ‘t items 54K in disk 43.8 MB available
it
Guest lost+found start startbak
i
=l [D]

Selectthe start folder icon.

4 Choose Make Alias in the File menu.

A new icon labeled start alias appears.

5 Drag the start alias icon to the desktop.

You can double-click the start aliasicon to open the start folder and use its files.

The next section, “What Are You Allowed to Do?” describes the tasks you can

perform while using different login accounts.
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What are you allowed to do?

Table 1-1 shows the types of actions you can perform in the different types of login
accounts. It also tells you where you can find more information about these tasks.

Table 1-1 What you can do

Who you are Tasks you can perform

Where to find information

Registered user  Log in and log out
Use UNIX programs and utilities
Create, print, manage, and store documents

Use Macintosh Applications
and desk accessories

Change your password
Connect to a network
Guest user Same as registered user

Root user All the above, plus:
Add user accounts

Shut down the system and start it up again

Add and manage peripheral devices

Set up and manage a network

Chapter 1

Chapters 2 and 4

Chapters 2 and 7
Macintosh Reference;
Application user’s guide
Chapter 8

A/UX Netwerking Essentials

Setting Up Accounts and
Peripherals for A/UX
Chapter 1

Setting Up Accounts and
Peripherals for A/UX; A/UX
Local System Administration
A/UX Network System
Administration; A/UX
Networking Essentials

When you're ready to stop working, see the next section “Logging Out,” for

instructions on logging out of A/UX.
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Logging out

When you finish your work with A/UX, end your work session by logging out. If you
walk away from your computer without logging out, anyone who uses your computer
has access to all your files, just as you do. If you log out, the next user must log in to his
or her own account to gain access to the system.

A Warning Logging out is not the same as shutting down the computer. When you log
out, the computer continues to run. In order to shut down the computer, you must be
logged in to the root account or you must know the root password. For information on
shutting down, see “Shutting Down A/UX” later in this chapter. A

Log out as follows:

1 ChooseFinderin the Applications menu to be sure that the Finder is the active
application.

The Applications menu appears when you click the icon at the far right of the menu bar.

2 Choose Logout in the Special menu under the A/UX Finder.
The system reminds you to save all your unsaved work.

After you log out, the Login dialog box reappears, indicating that you have logged out
successfully. The computer remains on, ready for the next user to log in.

Shutting down A/UX
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When you finish working you should log out, not shut down the computer. For
information on logging out, see “Logging Out,” earlier in this chapter.

Sometimes you need to shut down A/UX to do system maintenance, such as adding
peripheral devices, adding your system to a network, or repairing a file system. To shut
down the system properly, you need to know the password for the root account.
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Warning Don't use the switch on the back of the Macintosh computer to turn it off
while A/UX is running. Doing so might corrupt the file system and cause a loss of data.
Always use the correct shutdown procedure to turn off the computer. A

Shutting down the computer

Follow these steps to shut down the computer:

With either the Finder or the Login dialog box displayed, choose Shut Down
from the Special menu.

If you want to shut down and start up again immediately, choose Restart, instead of Shut
Down, from the Special menu. The Restart dialog box appears. The procedure is the
same as the shutdown procedure.

If you are not logged in to the root account, you see the Shut Down dialog box.

Shut Down... 3]
=

AL

You must have root privileges to shut
this system down.

Root password: || |

[ cancel | [ shutDown ||

Enter the root password in the appropriate text box.

If others are using the system, type a warning message in the next text box.
Your message is sent to other users.

If you are the sole user of this system, you are not asked for this information.

Type a number specifying the delay, in minutes, between the time the message
is transmitted and the time the other users must finish logging out.
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Give the other users a reasonable amount of time to save their work and to log out.

If you are the sole user of this system, you are not asked for this information.

5 Click Shut Down.

About system administration
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When several people use an A/UX system, a system administrator must maintain the
system. The system administrator sets up user accounts, backs up the system, sends
messages regarding procedures and schedules, maintains system security, and serves as
a troubleshooter for any problems that arise.

You might be the only person using the computer. In this case, you must act as your
own system administrator, using the root account to perform maintenance tasks. This
account has access to all files in the entire file system. Thus, if you're the system
administrator for your A/UX system, you should log in to your user account to do your
normal work. When you need to perform a maintenance task, you must log in to the
root account.

Maintaining the start account

The start account is meant to be used by new users. After someone uses it for tutorials,
the material in the start folder might well be altered. To restore it to its original condition,
runthe setup script asfollows:

Double-click the setup icon in the start folder.

The start folder is restored to its original form.

For further information on administering a system that is not part of a network, see
Setting Up Accounts and Peripherals for A/UX and A/UX Local System Administration.
For information on administering a system connected to a network, see A/UX Networking
Essentials and A/UX Network System Administration.
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2 Using Files, Folders,
and Directories

This chapter describes situations in which the use of folders and files in the A/UX Finder
differs from their use in the Macintosh OS. It also defines pathnames, that is, the way the
UNIX operating system describes the locations of files and directories in the file

hierarchy.

= The Finder in A/UX

= Using the Finder

= The Finder icons

m Using files and folders in the Finder

= Working with Macintosh files

»  Getting to the Macintosh Operating System
= Backing up and restoring files

= UNIX pathnames



The Finder in A/UX

As the Preface to this guide states, you should be acquainted with the basics of using the
Macintosh, including all the elements of moving, copying, opening, closing, naming, and
displaying files and folders in the Finder. Since these basic techniques are the same in the
A/UX Finder as they are in the Macintosh OS Finder, they are not taught in this guide.

Thereare a number of unique features in the A/UX Finder. This chapter concentrates
on these features and the ways in which they affect you.

Using the Finder

This section identifies the various objects that appear in the Finder in A/UX. You will
recognize the similarity between the A/UX Finder (shown in Figure 2-1) and the
Macintosh Finder. Note that the MacPartition folder is not open in Figure 2-1. As you
learned in Chapter 1, “Starting and Finishing a Work Session,” this window is open if you
have started A/UX manually. It might not be displayed if you have set A/UX to start
automatically. If Secure Startup is turned on (see “The Secure Startup Feature” in
Chapter 1), the MacPartition is not visible at all.

The A/UX Finder allows you to work with different A/UX and Macintosh applications
concurrently. You can copy and paste information between documents and applications
easily and quickly, without having to save the file from one application before you open
a file from an other application.

The Finder icons

The A/UX operating system contains many files and folders, each of which is represented
by an icon in the Finder. This section illustrates the icons you see and describes what
they represent.
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A/UX file
hierarchy icon

Home directory
folder

A second Macintosh
hard disk

MacPartition
icon

Figure 2-1 The A/UX Finder

Folders and directories

A reminder about terminology: In traditional UNIX terminology, the term directory is
used for the object that is called a folderin the Macintosh environment. Thus, in
traditional UNIX terms, the file system contains directories, which, in turn, can contain
files and other directories. This is also true of the UNIX file systems supported by A/UX.

Although users who are using UNIX in CommandShell (described in Chapter 3,
“Using CommandShell”) will find it useful to think in traditional UNIX terms, and will
refer to directories rather than folders, those who are using the Finder will prefer to think
in terms of the folder and file icons. Because the Finder is discussed in this section, the
term folder is used consistently here. In sections that discuss the A/UX command-line
interface, which is in the style of the UNIX system (for example, in “UNIX Pathnames,”
later in this chapter), the word directory is used.
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The icon for a given file or folder changes according to user permissions (for a

-

description of permissions, see Chapter 5, “Permissions”). Icons that are shaded, for

example, indicate that you have neither read nor write permission. Note that this refers
only to your permissions. Other users might have different permissions, and their own
permissions are reflected in the icons they see.

Folder icons

This section illustrates the different folder icons that you might see in the Finder.

.

Guest

f

start bak

=

locked folder

(=N
o
[=]
-
4 4
X

= | [0

—~

System Folder

E}D

stard alias

Folder: These two icons represent folders for which you have read
and execute permission, that is, the ability to open the folder and see
what files or folders are in it. You might or might not have write
permission, that is, the ability to add, rename, or remove items. The
marked tab on the bottom folder indicates that you own the folder, that
is, you created it, or ownership has been transferred to you.

Locked folder: This icon indicates that you cannot open this folder,
nor can you change any of its contents.

Drop box: This icon represents a folder for which you have write and
execute permission only. You cannot open the folder or read the files
in the folder, but you can place files in it.

Active System Folder: This icon represents the System Folder that the
system is currently using.

Home directory folder: This icon represents the alias of your home

directory folder. When it appears automatically, at the right edge of the
Finder screen, the name of the folder is normally your login name and

the word alias.
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File, application, and utility icons

The following icons represent various kinds of files in A/UX. They include files that are
commands, scripts, applications, and text documents.

g

john

bazename

A/UX text files: These icons represent a text file for which you have
read permission (top) and one for which you do not have read
permission (bottom). When you double-click the icon on the top, the
file opens using the default text editor. You cannot open the file on the
bottom because you do not have read permission. For information on
the default text editor, see “Changing the Default Text Editor” in
Chapter 8, “Customizing Your Work Environment.”

Binary data file: Thisicon represents a file thatis not a text file; it
contains code that can only be read by the computer or by a program.
You can neither read nor execute this file.

UNIX command: This icon represents a UNIX command. When you
double-click this icon, a Commando dialog box appears, which allows
you to run the command. Commando is described in Chapter 4, “Using
UNIX Commands and Commando.”

Shell script: A shell script, often called simply a script, is an
executable text file that contains a series of commands for the
computer to carry out. Many scripts are created by system
administrators and by users on site and are not an integral part of the
UNIX operating system. Note the similarity between this icon and the
A/UX command icon shown above it. This icon functions as though it
were a UNIX command icon, that is, double-clicking the icon displays
a Commando dialog box. If no Commando dialog box has been
created for the shell script, a default dialog box appears. For further
information on options and arguments and on Commando dialog
boxes, see Chapter 4, “Using UNIX Commands and Commando.” For
information on creating scripts, see A/UX Shells and Shell
Programming.
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dpplication

e

HyperCard

Executable file (without read permission): This icon represents a
file that you can run (such as an application), but for which you do not
have read permission. Many applications (such as those supplied by
third-party developers) represent their products with their own
custom-designed icons, which appear in place of this icon.

HyperCard application icon: This icon is an example of a Macintosh
application (the HyperCard application). Under A/UX, you can run
Macintosh applications, such as HyperCard, by double-clicking the
icon just as you do under the Macintosh OS.

File system icons

This section describes icons that represent the UNIX and Macintosh file systems.

——
/

(R

MacMartition

=

text backup

UNIX file system (or / folder) icon: This icon represents the root
level of the UNIX file system. For a discussion of the traditional
representation of the UNIX file system as an inverted tree, see “UNIX
Pathnames,” later in this chapter.

Macintosh file system: This icon represents a partition or a hard disk
that contains a Macintosh file system.

Macintosh floppy disk: This icon represents a floppy disk with a
Macintosh file system. A floppy disk that is formatted with a UNIX file
system does not display an icon. You can access it only through UNIX
commands in CommandShell. See “Inserting and Formatting Floppy
Disks,” later in this chapter.

Using files and folders in the Finder

Although the A/UX Finder allows you to use files and folders as you use them in the
Macintosh OS, A/UX does impose some of its own rules and limitations.
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Permissions limitations

Under A/UX, every file and folder has specific permissions that determine which users
are allowed to open a file or a folder, change a file’s or a folder’s contents, or run a
program. If you attempt to open a file or a folder or to change its contents when you lack
the necessary permission, an error message is displayed and you cannot proceed. An
example is shown in Figure 2-2.

For details on UNIX permissions, see Chapter 5, “Permissions.”

The folder “sample_dir” could not be
opened, because you do not have enough

access privileges.

Figure 2-2 The warning that you do not have the appropriate UNIX
permissions to open a folder

Naming or renaming files and folders

When you name or rename files and folders, observe the following restrictions:

1. Names can have no more than 31 characters.
2. Use only letters, numbers, or the underline character.

3. Do not use slash characters (/), spaces, or colons (:). Although slashes and spaces
work in the Macintosh environment, UNIX interprets a slash to mean that the
characters after the slash represent the next item in a pathname (for details, see
“UNIX Pathnames,” later in this chapter). UNIX interprets a space to mark the end of a
filename or directory name. Use an underscore ( _ ) instead of a slash or a space.

For example, avoid the following constructions:
A/UX file 1
The preferred form is as follows:

A_UX_file_1
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Working with Macintosh files

You can easily move your Macintosh applications and files to your UNIX file system, and
you can work with them just as you do when working in the Macintosh OS. The
advantage of moving them into the UNIX file system is that you can then use UNIX
backup facilities, search facilities, UNIX file permissions, and other utilities with your
Macintosh files.

If there are applications or other items that you must use with the Macintosh OS, you
might want to add another hard disk that contains a Macintosh file system because the
MacPartition is small.

If you attach a second hard disk with the Macintosh file system to your computer,
after you log in to your account (as described in “Logging In” in Chapter 1, “Starting and
Finishing a Work Session”) an icon representing that disk appears on your screen if the
additional disk is running. You can double-click this icon to open it and to use its files
and folders as you normally do in the Macintosh OS.

Getting to the Macintosh Operating System

2-8

Sometimes you might want to use the Macintosh OS exclusively. If the power has been
turned off, follow the directions in the next section, “If the Power is Off.” The instructions
in this section assume that Secure Startup is not turned on. If it has been turned on and if
you are not logged in to the root account, the MacPartition icon does not appear and you
cannot use the Macintosh OS. See “Secure Startup” in Chapter 1, “Starting and Finishing a
Work Session.”

If A/UX s running, proceed to the section called, “If A/UXis Running.”

If the computer is off

If the computer has been turned off, and if A/UX is set for automatic startup, you need to
cancel the automatic startup procedure. Follow these directions:
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Press the Powzr ON key to turn on the computer.

First the copyright screen appears.

With the copyright screen displayed, hold down the CommaND key while
pressing the period key.

If the copyright screen disappears before you have done this, a startup screen appears.

If the copyright screen vanishes before you perform step 2, click Cancel in the
Startup screen during the first five seconds of the startup procedure.

If Secure Start is not running, you see the A/UX Startup window with the aA/ux
Startup # prompt

Choose Quit from the File menu.

The Macintosh OS Finder appears. Icons for the Macintosh HFS hard disks connected to
your system appear on the right side of the screen. Note that the icon for the UNIX file
hierarchy does not appear. The Macintosh OS does not recognize the UNIX file system.

If A/UX is running

If the computer is on and running A/UX; follow these directions:

Choose Restart from the Special menu, with either the Finder or the Login
dialog box displayed.

The Restart dialog box appears.

Enter the root password in the appropriate text box.

If you are already logged inas root, you are not asked for the root password here.

If others are using the system, type a warning message in the next text box.

Your message should warn other users that the system is about to be shut down and that
they should save their work and log out. The message is broadcast to other users.

If you are the sole user of this system, you are not asked for this information.
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4 Type a number specifying the number of minutes users have until the system
actually shuts down.

Give other users a reasonable amount of time to save their work and to log out.

If you are the sole user of this system, you are not asked for this information.
Click Restart.

6 With the copyright screen displayed, hold down the CommanD key while
pressing the period key.

If the copyright screen disappears before you to do this, a startup screen appears.

] Ifthe copyright screen disappears before you perform Step 6, click Cancel in
the Startup screen during the first five seconds of the startup procedure.

8 Choose Quit from the File menu.

The Macintosh OS Finder appears. Icons for the Macintosh OS hard disks connected to
your system appear on the right side of the screen. Note that the A/UX / disk does not
appear. The Macintosh OS does not recognize the A/UX file system.

To begin using a file on your Macintosh HFS hard disk, open it by double-clicking its
icon. Refer to the Hard Disk SC Owner’s Guide or to the owner’s guide that came with
your hard disk or your computer for information about setting up and using files and
folders on this disk.

Backing up and restoring files
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This section shows you how to make backup copies of your critical files on floppy disks
and to restore them from floppy disks.

It is important that you make backup copies of individual files as you create and
revise them, and that your system administrator back up the entire system periodically.
This prevents you from losing data or programs should your disk or your system fail.
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For information on backing up your entire system, see A/UX Local System
Administration.

Inserting and formatting floppy disks

Before you can use a brand new floppy disk, you must format the disk. This means that
the computer writes information on to the disk, information that enables it to accept
either the Macintosh or the UNIX file system.

When you insert floppy disks, the system can respond in a variety of ways,
depending on how the floppy disk was formatted and whether you are currently working
in the Finder or in CommandShell.

If you want to back up a folder or a file by dragging an icon to the floppy disk icon,
you need to be in the Finder and to insert a formatted floppy disk. For further
information on this method of backing up files, see “Dragging to Copy a File to a Floppy
Disk,” later in this chapter.

For more information on CommandShell, see Chapter 3, “Using CommandShell.”

If you are in the Finder

If the floppy disk that you insert is formatted for the Macintosh file system, its icon,
shown in Figure 2-3, appears near the right edge of the screen.

=

text backup

Figure 2-3 A Macintosh floppy disk icon
If the floppy disk has not been formatted for the Macintosh file system, you see a

series of dialog boxes warning you that this is the case. These dialog boxes (illustrated in
Figure 2-4) guide you through the formatting process, as follows:
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s This disk is unreadable:
|| Do you want to initialize it?

[ Eject || [one-sided] [Two-Sided]

This process will erase all
information on this disk.

Comee ) Gl

Figure 2-4 Disk-formatting dialog boxes
In the first dialog box, click Two-Sided.

When the second dialog box appears, click Erase.

You can click Cancel if the disk contains data that you don't want to erase.

If you are in CommandShell

If the floppy disk that you insert contains UNIX data (for example, a UNIX file system)
nothing happens; no icon appears and no dialog box appears. Therefore, you can work
with it only by using UNIX command-line commands. You can use it for backing up files
with UNIX backup utilities, such as tar or cpio (which are described in A/UX Local
System Administration).

If the floppy disk has never been formatted, you see the top dialog box in Figure 2-4.
If it is a Macintosh disk, a dialog box (shown in Figure 2-5) asks you to specify whether
you want to use it for the Macintosh file system or for a UNIX file system. A third choice is
to eject the disk (and therefore to cancel the procedure).

= Ifyou click UNIX Data, after the initialization is complete, the disk behaves like the
UNIX disk described above (that is, no icon appears).

= Ifyou click the Macintosh button, the ensuing dialog boxes guide you through the
initialization process for a Macintosh file system disk, as shown in Figure 2-4. You
must use the Macintosh disk with the Finder.
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This is a Macintosh disk.
What do you want to use it as?

Figure 2-5 Initializing for a Macintosh or a UNIX data disk

Dragging to copy a file to a floppy disk

A/UX provides an easy way to copy files and folders. Follow these steps:
Be sure that you are in the Finder.

Insert a floppy disk (initialized for the Macintosh file system) into the
disk drive.

You see an icon representing the disk.

Drag the icon of the file or folder that you want to copy to the floppy disk icon.
A dialog box appears describing the progress of the copy operation.

You can shift-click to select multiple files or folders to back up.

Dragging to restore a file

A/UX provides an easy way to restore files or folders that were backed up by dragging
their icons to a disk. Follow these steps:

Insert in the drive the floppy disk containing the file you want to restore.

You see an icon representing the disk.

Double-click the disk icon to display a window that shows the contents
of the disk.
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5 Drag the icon of the file or folder that you want to restore to the folder on the

hard disk where you want it to reside.
A dialog box appears describing progress of the copy operation.

You can shift-click to select multiple files or folders to restore.

UNIX pathnames
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This section describes the way the UNIX operating system specifies the location of files
and directories in the UNIX file hierarchy. The tutorial exercises in Chapter 4, “Using
UNIX Commands and Commando,” make use of the information in this section.

A/UX differs from traditional forms of UNIX in that the Finder allows you to
manipulate files and folders by manipulating their icons. However, if you need to work
with the command-line interface available in CommandShell, you will find it necessary to
understand UNIX pathnames.

The folders of the Macintosh environment correspond to the directories of the UNIX
world. Since this section describes the traditional UNIX way of using pathnames in the
A/UX CommandShell window, the word directory is used here.

The UNIX file system is organized in a hierarchy traditionally represented as an
inverted tree. Figure 2-0 shows an example of this organization. Organized from top to
bottom, the file system begins at the top with the / directory, which is called the root of
the file system and is always represented by the slash character(/). Branching downward
from the root of the file system are the rest of the directories and files in the system. The
/ directory contains a number of directories that store the operating-system files and
programs. There is only one UNIX file hierarchy for a given system. All additional
directories, file systems, and files fall within this hierarchy (shown in
Figure 2-0).

Because of its hierarchical organization, A/UX uses pathnames to refer to files and
directories. A pathname is a name that describes where the file or directory is located in
the hierarchy. Here is an example:

/users/start/letterl

Figure 2-7 shows the path that leads from the root tothe file 1etter1 and that gives
rise to the pathname /users/start/letterl.
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| bin dev etc | users tmp mac
pubs I Guest start |s:art.bak

5 )

T . Y,
art text

T Y
james paul

iy

memol letterl scshrc eclipboard *login

Figure 2-6 Part of the A/UX file-system structure
Here, the file named letter1 islocated withinthe start directory, which is

located within (or below, in UNIX terminology) the users directory, which, in turn, is
located below the / directory (indicated by the / character).
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Figure 2-7 The pathname /users/start/letterl
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An absolute pathname of a file shows the complete path from the root to the file in
question, by listing all directories that lead from the / directory and concluding with the
filename itself. The first item in an absolute pathname is always the character /, which
indicates the root. Thereafter, the slash character is used to separate the names of the
directories.

We know, for example, that /users/start/letterl isan absolute pathname
because it begins with the slash character, and is thus tracing the path from its origin at
the root. The subsequent slash characters separate the names of the users andthe
start directories, and the names of the start directory and file 1etteri.

A relative pathname lists the directories leading to the file, beginning with the
current directory.

The directory in which you are currently working is called the current directory.
When you change directories, the directory you move to becomes your new current
directory. For example, if the current directory is /users,then start/letterl isa
relative pathname of /users/start/letteri. Note thata relative pathname never
beginswiththe / character, because it doesn't start at the root. This can be compared
with leaving out the area code in a telephone number if you are calling the number from
within that same area code.

Figure 2-8 diagrams the relative pathame start/letterl.

The name of the file or of the directory whose path is being described is the last
component of a pathname.

When typing UNIX commands in the CommandShell command-line interface, if you
want to specify a file that is in your current directory, just type the filename. You needn't
specify its directory, because you're already working in that directory. For information on
CommandShell, see Chapter 3, “Using CommandShell.” For information on UNIX
commands, see Chapter 4, “Using UNIX Commands and Commando.”

Two dots (. .) are an abbreviation for the directory that contains the current
directory. For example, if you are in /users/start, you can specify the /users
directory with two dots (. .) as a shortcut.

Once you understand how UNIX pathnames work, you can easily learn to find your
way around a UNIX hierarchy while working with the command-line interface. For
further details, see the section called “Using UNIX Commands to Navigate the File
System” in Chapter 4, “Using UNIX Commands and Commando.”
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Important If you are working in the Finder and you open a new CommandShell
window, the current directory of the CommandShell window is your home directory. If
you bring to the foreground of the screen a CommandShell window that has been used,
the window is still in the directory it was in when it was last used. The folder that you
have been using in the Finder does not determine the directory in which your
CommandShell windows are working,.
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3 Using CommandShell

This chapter describes how to use CommandShell, an application that provides access to
the traditional UNIX command-line interface. This chapter contains the following

information:

= What is CommandShell?

= Making CommandShell active

= Using CommandShell windows

= Using the A/UX System Console

= Customizing CommandShell windows

= Using terminal emulation

= Using Macintosh editing tools in CommandShell windows

»  Leaving CommandShell

Start by reading the first two sections of this chapter, (“What is CommandShell?” and
“Making CommandShell Active”). You can then consult any of the remaining sections

that describe the tasks you want to perform.



What is CommandShell?

CommandShell allows you to display one or more windows in which you can
communicate with A/UX by entering commands on a command line, as is traditionally
done on most UNIX systems. When you do this, you can communicate with A/UX
through any one of three standard shells:

s Cshell
s Bourne shell

s Korn shell

Like the Finder, a shell is a utility that establishes an interface between you and the
operating system. It accepts the commands that you enter and passes them on to the
operating system, which executes them. It also displays the operating system’s
responses. There are several standard shells, each of which interprets your commands
and the operating system'’s responses somewhat differently than the others. Since the C
shell is one of the most commonly used UNIX shells, it is the default shell when you log
in to your user account (unless your system administrator has changed the default shell).

For information on changing shells, see “Changing Shells” in Chapter 8, “Customizing
Your Work Environment.”

Making CommandShell active

3-2

Before you read this section, you should start A/UX and log in to your user account.
When you log in, the A/UX Finder is active and its menu bar appears at the top of
the screen.

To make CommandShell active:

Choose CommandShell from the Applications menu, which is at the right side
of the menu bar.

The Applications menu is shown.
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Hide CommandShell
Hide Others
Shaw i

[d] CommandShell
Finder

A window labeled CommandShell 1appears and becomes the active window.

s([[==——————— CommandShell 1
pacer.start 1 8 l

e

o

When the CommandShell window becomes active, the CommandShell menu bar
appears. It contains commands that allow you to manipulate the CommandShell
windows and their contents.

Switching between CommandShell and the Finder

You can return to the Finder by clicking on any portion of a Finder window with your
mouse pointer or by choosing Finder in the Applications menu. You can then reactivate
CommandShell by clicking on any portion of a CommandShell window or by choosing
CommandShell in the Applications menu.
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Important If you open a new CommandShell window, the current directory of the
CommandShell window is your home directory. If you bring to the foreground of the
screen a previously used CommandShell window, that window is still in the directory it
was in when it was last used. The folder that you are using in the Finder does not
determine the directory in which your CommandShell windows are working,

Using CommandShell windows

3-4

The following sections explain how to work with CommandShell using the menu
commands. You can read through these sections sequentially or you can find the task
you want to complete and go directly to the section that applies to it.

Displaying CommandShell windows
When you make CommandShell active, a CommandShell window appears. You can
display additional windows in two ways:

Choose New from the File menu.

Press CoMMAND-N .

Either of these actions makes a new window appear in front of the existing window or
windows. The CommandShell windows are numbered in the order in which they are
created (CommandShell 1, CommandShell 2, and so on).

¢ Note You can open up to 15 windows. It is best to use a large-screen monitor when
you work with many windows at the same time.
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Arranging CommandShell windows

You can arrange CommandShell windows on the screen in three ways.

= Standard positions: When you create a new window, it appears in front (and
slightly below and to the right) of the previously created window, partially obscuring
the windows behind it (Figure 3-1).

Tiled positions: You can tile the windows to arrange them alongside each other
with their edges touching, like tiles on a floor. For information on different tiling
patterns, see “The CommandShell Environment” in Chapter 9, “A/UX Reference.”
Tiling windows reduces the size of the windows so that they fit on the screen.

= Manual positions (resizing and dragging): You can arrange CommandShell
windows on your desktop manually by using their resize boxes to resize the
windows and by clicking their title bars to drag them to new locations on the
desktop.
CommandShell 1 I
@ Commandshell 2 |
= CommandsShell 3 |
[rsJ===—===——— Commandshell 4 =E
pacer.start 1 8 [ | ﬁ
= ]
&

Figure 3-1 Windows in standard position
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A Warning Unlike a standard Macintosh window, if a CommandShell window is so
reduced in size (because of tiling or resizing) that its contents cannot be seen,
CommandShell erases the obscured screen output. You cannot retrieve it by enlarging
the window. A

For further information on tiling, sizing, moving, and hiding CommandShell
windows, see “The CommandShell Window Menu” in Chapter 9, “A/UX Reference.”

Recording the contents of a window

As you add new lines to a CommandShell window, the top lines can scroll past the top
edge of the window, as shown in Figure 3-2. CommandShell automatically records a
preset number of these lines. This allows you to review them by scrolling upward.

By default, CommandShell records 1000 lines. For information on how to change this
default, see “Customizing CommandShell Windows,” later in this chapter.

Figure 3-2 Recording window contents as they scroll off the top
Figure 3-3 shows how the window looks after you use the scroll bar to redisplay the

recorded lines. The dotted line across the window marks the top of the most recent
screen. It separates the active area (the material below the dotted line) from the recorded
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area (the material above the dotted line). You can change the material in the active area
(that is, the area that contains material that has not yet scrolled off the top of the
window) but not the material in the recorded area.

] CommandShell 1 HIE
1.7 .kshre .profile
vt .login System Folder alias
.Examp | sBackUp logout letter
.aux_prefs .mac/ memo 1
S i .cshre .mailrc setup#
Retoidedllneb localhost.start 1 8 Is =1 / fusers
(inactive area)
'
total 4228
I rwsrwsrws 1 start project 42 Mouw 11 16:24 Desktop Folder =* Jjusers/s
_-tart/.mac/localhost/Desktop Folder
ER==re=p=— 1 root root 487165 Oct 28 13:04 FILES
drwxr=xr-x 2 bin bin 2560 Oct 28 19:36 bin
drwxr-xr-x 12 bin sys 2048 Nov 11 16:24 dev
drwxrwxr-x 16 bin sys 3072 Nov 6 17:23 etc
? drwxr-xr-x 4 bin bin 512 Oct 28 19:35 1ib
Active area drwxr=xr-x 2 bin bin 4096 Oct 24 19:37 lost+found
drwxr-xr-x ? root root 512 Dct 28 19:35 mac
drwxrwxrwx 2 root root 512 Oct 24 22:01 mnt
=Rl=tr—h— 1 root root 815257 Oct 25 84:19 newunix
mRWER——R== 1 root root S Oct 25 04: 1% nextunix
drwxr-xr-x 2 root root 512 Oct 28 19:21 root
|_[drwxr-xr-x 2 root root 512 Oct 28 19:23 shlib

Figure 3-3 Viewing recorded window contents

¢ Note CommandShell does not save the recorded lines for use after you close the
window. If you have accumulated data that you want to save, select itand copy ittoa
file in a text editing or word processing program. See “Saving a Selection in a New File,”
later in this chapter.

Canceling the recording of window contents

You can stop CommandShell from recording the top lines of the active window as
follows:

®  Choose Don’t Record Lines Off Top from the Commands menu.

This command causes CommandShell to stop recording lines as they scroll past the top
of the active window. Any lines already recorded are saved and are still available for
review. The command name in the Commands window changes to Record Lines Otf
Top. Choose this to begin recording the lines again in the same window.
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Erasing recorded window contents

To erase recorded lines, do the following:

Choose Clear Lines Off Top from the Commands menu.

The recorded lines are erased and are no longer available for review. The scroll bar
becomes white. This command operates only on the active window.

Closing CommandShell windows

Before you can close a window, it must be the active window. The active window has
horizontal stripes running across its title bar. To make a window active, point to it with
the mouse cursor and press the mouse button.

Closing a window

There are three ways to close an active window:
Choose Close from the File menu.

Press CoMMAND-W,

Click the close box of the window.

In each case, the CommandShell window disappears from the screen.

¢ Note CommandShell does not save any lines after you close the window. If you
don’t want to lose your work, save the contents to a file. To save the text of A/UX
command lines to a file, see “Saving a Selection in a New File,” later in this chapter. o

If you close a window in which a process or program is running, the process or
program halts. An alert box warns you of this and gives you the option to keep the
window open.
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Closing all open windows

You can close all the open windows at once, as follows:

B Choose Close All Windows from the File menu.
The CommandShell windows disappear from the screen.

If one or more of the windows contains a process or a program that is running, the
process is halted. An alert box warns you of this.

& Close "CommandShell 1"

even though there are jobs
running?

Using the A/UX System Console

Whenyouare working in A/UX, the system might generate messages regarding its
status. In a traditional UNIX environment, these messages appear on a console terminal.
Typically, the system administrator monitors these messages, which alert the
administrator to take action to avert or remedy a problem. In A/UX, the system messages
appear in the A/UX System Console, a CommandShell window that you display by
choosing its name from the Window menu.
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Displaying at the A/UX System Console window

To view the contents of the A/UX System Console window, follow these steps:

1 choose Commandshell from the Applications menu.

This action displays an active CommandShell window and makes the CommandShell
menu commands available.

2 Choose A/UX System Console from the Windows menu, or press COMMAND-0
(that is, the number “zero”).

This action displays the A/UX System Console window. For more information on the
messages that you might see in the window or for information on how to respond to a
request for information, see A/UX Local System Administration.

Clearing the A/UX System Console window
To clear the messages from the A/UX System Console window, follow this step:

®  ChooseClear Lines Off Top from the Commands menu.

This action clears all the information from the window. You should clear this window
periodically so that you can tell when new messages appear.

Closing the A/UX System Console window

Close the A/UX System Console window just as you close any CommandShell window
(see “Closing CommandShell Windows” earlier in this chapter). Note that unlike other
CommandShell windows, when you close the A/UX System Console window, nothing in
the window is lost. Closing the System Console window is equivalent to “hiding” it.
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How A/UX warns you of an alert

If A/UX needs to bring an alert to your attention (for example, if the system administrator
is preparing to shut down the system), an icon flashes in the menu bar and an alert box
appears. If CommandShell is not the active application, a diamond-shaped symbol also
appears alongside CommandShell in the Applications menu. Choose this to activate
CommandShell; then choose A/UX System Console from the Windows menu to display
the alert message.

You can change this default to suppress the alert box, the flashing menu-bar icon,
or both.

To change this default, do the following:

Choose Notification Levels in the Preferences menu.

The Notification Levels dialog box appears.

Set the notification level to be used when
CommandShell is not the front application.

When a console message is received:

+ (O Only display ¢ in € menu
i ¢ O Also flash icon in menu bar
= + @ Also display alert
= QO Only display alert
When a process needs input from the console:
+ O Only display ¢ in & menu
+ O ARiso flash icon in menu bar
= + @ Riso display alert

(Cancel | [ ok |

After you click the appropriate buttons, click OK.
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Customizing CommandShell windows

If you use CommandShell windows often, you might find it convenient to establish an
ideal arrangement of windows, so thatas soon as you log in to A/UX, the windows
appear exactly the way you want.

Presetting window defaults

The Active Window Settings command in the Preferences menu allows you to do the
following steps:

= save an initial command to execute upon activating CommandShell
= change the title of the window

» change the number of lines to record

You can preset window defaults as follows:

®  Choose Active Window Settings in the Preferences menu.

The Active Windows Settings dialog box appears.

Active Window Settings

Window title: |GInInGHTATEIIN]

Window position: Window size:

Top: [324 | Rows: 24
Left: @ Columns: [80

X Record lines off top

Magimum number of lines:

Initial command: | |

r=
(‘Terminal settings... | 1 0K l
N —

The name of the active window is highlighted in the top line.
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You can change any or all of the settings in this dialog box. After you click OK, the
new settings affect the active window. If you saved the new settings by choosing Save
Preferences in the Preferences menu, the new settings become the new defaults for
displayed windows. See “Saving the Layout of Your CommandShell Windows,” later in
this chapter.

Notice that the check box “Record lines off top” is selected by default. If you click it,
the X mark disappears and recording of lines is turned off. You also can change the
maximum number of lines recorded, but only if “Record lines off top” is selected.

In the “Initial command” text box, you can enter a command to run automatically as
soon as you activate CommandShell.

Presetting the appearance of new windows

You can change the default settings that control the appearance of new windows before
you create them. Follow these steps:

®m  Choose New Window Settings from the Preferences menu.

The New Windows Settings dialog box appears.

New Window Settings

L Use Active Window Settings ]

Window Cascade Origin: Window Size:
Top: (40 Aows: ‘24
Left: [2 Columns: {80

Font: | UT100 | Size: [ 9 ]

Maximum number of lines recorded off top:

[Terminal Senings...] l 0K l
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You can extend the active window settings to all new windows. To do so, click Use
Active Window Settings.

If you want to label new windows with a prefix other than “CommandShell,” type the
prefix in the Window Title Prefix text box.

You also can preset the window size, the screen font to be used in the window, and
the maximum number of lines to be saved by typing your choices in the appropriate
boxes.

To preset a default position for the upper-left corner of the first window of a group of
stacked windows, enter the coordinates (in pixels) in the Window Cascade Origin text
box.

Saving the layout of your CommandShell windows

The Save Preferences command (in the Preferences menu) allows you to save the
following specifications:

= notification level preferences (see “How A/UX Warns You of an Alert,” earlier in this
chapter)

= the positions and sizes (in rows and columns) of all CommandShell windows

= the stacking order of the windows

= the titles of the windows

= the fonts and point sizes of text in the windows

= whether a given window is visible or hidden

= whether a given window is zoomed (that is, enlarged to full-screen size with the
Zoom Window command in the CommandShell Window menu) and the sizes (in
pixels) of its zoomed and unzoomed states

= whether lines are to be recorded off the top of the screen, and the number of lines to
be recorded (see “Recording the Contents of a Window” and “Presetting the
Appearance of New Windows,” earlier in this chapter)

= the initial command to be run in the window (see “Presetting Window Defaults,” later
in this chapter)

m terminal emulation information

Chapter 3 Using CommandShell



To save the settings you choose, follow these steps:

Arrange the windows just as you want them to be.

Be sure that you have chosen any special formatting features that you want
(such as fonts).

Choose Save Preferences in the Preferences menu.

Restoring the window layout to the saved preference

If you have saved your window preferences but have changed the window layout on
your screen, you can instantly restore your preferred layout as follows:

Choose Restore From Preferences in the Preferences menu.

When you log out or shut down the system, if you have changed your window
preferences with the Active Window Settings or the New Window Settings dialog box,
but have not saved them by choosing Save Preferences in the Preferences menu, you are
asked whether you want to save the changed preferences.

& Do you want to save your

changed preferences?

ST

Click Yes or press RETUrN to save the changed preferences or click No to abandon them.
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Using terminal emulation

The CommandShell window emulates the Digital Equipment Corporation VT102
terminal. At present, this is the only terminal emulation that CommandShell supports,
though it ultimately will provide other terminal emulations. Although terminal emulation
for the VT102 terminal is the only one currently shipped with A/UX, you can purchase
others from other sources. For example, there is an Apple Computer product called
MacTerminal, which contains a VT320 emulation tool that you can install. However,
since A/UX is shipped only with the VT102 tool, that is the only one discussed in this
manual.

Inaddition to the features discussed earlier in “Customizing CommandShell
Windows,” you can customize the VT102 features just as you would on a VT102 terminal,
as follows:

1 Choose Active Window Settings in the Preferences menu.

2 Click the Terminal Settings button.

The Terminal Settings dialog box appears.

Terminal Settings [ ok |
Emulation: | CommandShe...v |

Terminal Mode: | _ANSI/VT102 ¥ Text Cursor

@) : il @ Elogk
X on Line il O Underline
1 D Local Echo

H D Show Status Bar
D Show Tab Ruler

Answerback Message |

Keyboard |

To the right of the word Emulation there appears a pop-up menu that will eventually
allow you to choose between several terminal emulations. At present, only the VT102 is
available.
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Along the left margin of the dialog box there are four setup icons, which allow you to
select General, Screen, Keyboard, and Character Set.

Since most A/UX users do not have need to change the default terminal emulation
capabilities, these capabilities are described in “Terminal Emulation” in Chapter 9, “A/UX
Reference.”

For more information on the VT102 terminal emulator, see “VT102 Terminal
Emulation Tool” in Apple MacTerminal, a manual that describes other terminal
emulation tools available for the Macintosh.

Using Macintosh editing tools in
CommandShell windows
You can use some of the standard Macintosh editing procedures while working in
CommandShell windows. This allows you to paste a series of commands or a long,
complex command into another window without having to retype it.
The sections that follow describe how to copy or paste the contents of a window
using the mouse and the menu commands. This material applies to command lines,

system messages, and the output of commands. If you are using a text-editing
application, use the editing tools provided by the application.

Selecting text

You must select text before you perform the editing procedures. Select text as follows:

B Drag across text to select a single letter, word, or section of text.

Text is highlighted when it is selected.
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Copying text

To copy text, follow these steps:
Select the text you want to copy.

Choose Copy from the Edit menu or press CoMmanp-C.

The highlighted text is copied to the Clipboard. You can paste the Clipboard contents as
many times as you want. For more information about the Clipboard and its contents, see
Learning Macintosh or the Macintosh Reference.

Pasting text

Once you have copied text to the Clipboard, you can paste the text in a
CommandShell window as follows:

Choose Paste from the Edit menu or press CoMMAND-V.

The text is pasted at the command prompt. You can paste the Clipboard contents as
many times as you want, until you replace them by copying or cutting something else.
For more information about the Clipboard and its contents, see the owner’s guide that
came with your computer. For more information about the Clipboard and its contents,
see Learning Macintosh or the Macintosh Reference.

Changing the font or font size

You can change the appearance of all the textin a CommandShell window by changing
the font or font size. The choices available in the Fonts menu are the monospaced fonts
in the System file. At the bottom of the list of available font sizes in the Font menu, the
last item, Other, allows you to select any font size that does not appear in the list.

& Note If the active window uses a terminal emulation tool that does not support font
changes, the Fonts menu is disabled. o
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You can change the font or font size as follows:

Choose the font or font size you want from the Fonts menu.

All text in the window changes to the new font or font size.

If you choose Other, the Font Size dialog box appears. Type the font size in
points and click OK.

( cancel |

Font size:D
ok ]

The screen fonts change to the size you type.

Saving a selection in a new file
You can save the contents of a CommandShell window in a text file. When text is present

in a CommandShell window, follow these steps:

Select the text you want to copy into a new file.

The text appears highlighted.

Choose Save Selection from the File menu.

The Save Selection dialog box appears. See the Macintosh Reference f you need
assistance in saving the file to a different drive.

I Saup

=/
‘ tettert { Ejeet |
0 mpmnd
0 Pistwre Desktop
0 setfup
O Sysiem Folder 6/i6s
0 saun.prefs SRIECEETEREEEES
Save current selection as:
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Type a name for the new file.

4 Click Save.

Printing the contents of a CommandShell window

You can print all or part of the contents of a CommandShell window as follows:

1 Select the portion of the window that you want to print.

You can select the entire contents of the window by choosing Select Al in the
Edit menu.

2 Choose Print Selection in the File menu.

The Print dialog box appears.

Job EI

LaserlWriter “Dan Horn” 70 I'|

l:upies:lil Pages: @ All O From: Ij T l:

Cover Page: @ No QO First Page O Last Page

Paper Source: @ Paper Cassette (O Manual Feed
Print: @ Black & White (O Color/Grayscale
Destination: @ Printer QO PostScript® File

3 Click Print.

For assistance in setting up your printer, see Setting Up Accounts and Peripherals

Sfor A/UX.
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Leaving CommandShell

Make sure thatyou have saved any work that you complete in CommandShell windows
before you return to the A/UX Finder. There are several ways to leave CommandShell:

®  Choose Hide CommandShell from the Applications menu.

This action closes all the windows and sets CommandShell aside until you reactivate it.
This method reduces screen clutter while you work with other applications.

B Choose another application from the Applications menu.

This action moves the CommandShell window to the background of the screen. The
application you have chosen becomes active.

®  Choose Quit in the File menu.

This turns off CommandShell. The only reason for turning off CommandShell is to load
new fonts, which you cannot do unless all applications are turned off. By default, there is
a file in the Apple Menu Items folder (located in the System Folder). This allows you to
turn CommandShell on again by selecting CommandShell in the Apple menu.

If the CommandShell file has been removed from the Apple Menu Items folder in the
System Folder, you can restart CommandShell by double-clicking the CommandShell
iconinthe /mac/bin folder. Do this as follows:

I Double<lick the / folder to open it.

2 Double-click the mac folder to open it.

3 Double-click the CommandShell icon.

CommandShell begins to run.
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4 Using UNIX Commands and
Commando

This chapter teaches you how to use UNIX commands on the command line and how to
use Commando dialog boxes to perform a variety of useful UNIX operations. It also
shows you how to consult information in the A/UX Command Reference on screen. The

following information is presented in this chapter:

= About UNIX Commands

= What isa command?

= Using UNIX commands to navigate the file system
= Getting your bearings

= Options and arguments

»  The Commando dialog box

s Using Commando

= Further useful UNIX operations

If you are unfamiliar with UNIX commands, read the opening sections of this chapter in
sequence, through “Options and Arguments.” If you feel comfortable with the command-

line interface, go directly to “Using Commando.”



About UNIX commands

Chapter 3, “Using CommandShell,” tells you how to use CommandShell, the UNIX
command-line interface. When you enter a command on the command line, you are
instructing A/UX to run a program that performs a specific task or a specific set of tasks.
Entering the command on the command line is the traditional UNIX way of running
commands. You also can run these commands with the A/UX application called
Commando, which displays a dialog box that offers you an easy way to use a UNIX
command and to choose among the various options that the command offers.

Important As you go through the tutorials that use UNIX commands, be sure that you
enter them exactly as specified in the exercises. Don't add or remove spaces, don'’t
change a character from uppercase to lowercase, or vice versa, and be sure to use minus
signs where appropriate.

What is a command?

4-2

A command consists of a special kind of file called a program, which is an executable
file, that is, a file that contains a set of instructions that makes the computer perform a
specific task. A/UX contains over 500 such commands.

For example, there is a command called pwd, which stands for print working
directory. This command makes the computer display the pathname of the directory in
which your CommandShell window is currently working (your current directory).

To perform the following exercises, be sure that you are logged in to the start
account. If you do not have a CommandShell window displayed, choose CommandShell
in the Applications menu. If a CommandShell window does not appear when you
choose CommandShell in the Applications menu, immediately choose New in the File
menu, and a new CommandShell window appears.
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Enter the following command by typing the command and pressing RETURN:
pwd

The pathname of your current directory (/users/start) appears in response to the
pwd command.

s[[==——————— CommandSheli 2
pacer.start 1 & pwd ]
/users/start

pacer.start 2 8 I

[2[<]

The pwd command caused the program (the executable file) called pwd to run,
that is, to execute its instructions. The results of the command are commonly called the
output. In the case of the pwa command (as is true of many commands), the output is
displayed on the screen. In traditional UNIX parlance, one says that the output is
directed to the screen. This is called the standard output.

Later in this chapter you will see that you can instruct a command to send its output
somewhere other than to the screen. For example, the information can be sent to a file to
be saved or to a printer to be printed. This rechanneling of data is called redirection.
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Using UNIX commands to navigate
the file system

Chapter 2, “Using Files, Folders, and Directories,” tells you how CommandShell refers to
files and directories by their pathnames (see “UNIX Pathnames”). You can use
pathnames to determine where you are in the A/UXfile system and to move from
directory to directory in CommandShell.

Note that although you can work within the files in MacPartition while using the
Finder (if Secure Startup is not on; see “The Secure Startup Feature” in Chapter 1,
“Starting and Finishing a Work Session”), you cannot use CommandShell to work with
the contents of MacPartition or any other Macintosh file system.

Important If you are working in the Finder and you open a new CommandShell
window, the current directory of the CommandShell window is your home directory. If
you bring to the foreground of the screen a CommandShell window that has been used,
the window is still in the directory it was in when it was last used. The folder that you
have been using in the Finder does not determine the directory in which your
CommandShell windows are working.

Getting your bearings

This section describes how to determine what account you're using, what directory
you're using, and how to move to another directory.

Finding your user account name
If you forget your login name, use the whoami command to find out what it is.

Follow these instructions:
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Choose CommandShell in the Applications menu.

A window appears on the screen. CommandShell is described in Chapter 3, “Using
CommandShell.”

Enter the whoami command.

Remember that you enter a command by typing the command and pressing the RETURN
key. In a few seconds you see a response that identifies the account name.

Where are you?

If you are working in CommandShell and you don’t know what directory you are in, use
the pwa command as follows:

Type pwd and press Return.
The name of the current directory (the directory in which you are currently working) is
displayed.

For information on moving from directory to directory, see the next section:
“Changing to a New Directory; Returning to Your Home Directory.”

Changing to a new directory; returning to your
home directory

Suppose you use the pwd command and find that you are working in the root directory
(indicated by a /) when you really want to be working in the /users/start
directory. To change from directory to directory, use the cd (change directory)
command. Changeto /users/start asfollows:

On the command line, enter cd /users/start

Important Don't neglect to enter the space after cd. The space marks the end of the
command and the start of the command argument (described in the next section).
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If you enter pwd now, the response reads as follows:
/users/start

When you use the cd command, you can use the absolute pathname or relative
pathname of the destination directory, whichever is easiest for you. If you aren't sure
where you are relative to the destination directory, use an absolute pathname.

You can always return to your home directory by entering the cd command
without specifying any directory.

Options and arguments

4-6

Options and arguments modify the way a command runs and specify the files (or other
objects) upon which the command operates.

Options

Most UNIX commands can run in a variety of ways to produce a variety of results. These
variations in the way a command works are called options.

Listing the contents of a directory: the 1s command options

For example, the 1s command causes the computer to list all the files in your current

directory. However, there are various ways in which you can list the files. If you use the
1s command without any of its options, only the names of the files are listed, and they
are listed in a one-column list.

Let's say that you are working in the start directory with your CommandShell window
displayed. To be sure that this is the case, do the following:

Enter the pwd command to see what directory you are in.

The command line should display the following response:

/users/start
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If this is not what appears enter the following:

cd /users/start

Repeat Step 1 to be sure thatyouare inthe /users/start directory.

For further information on the pwd and cd commands, see “Changing to a New
Directory; Returning to Your Home Directory,” earlier in this chapter.

The following steps introduce you to several of the 1s command options:

Enter 1s onthe command line of a CommandShell window.

The resulting display looks something like this:

E[(I=—— CommandShell 2 =——————1]

pacer.start 1 8 puwd il
/users/start

pacer.start 2 8 |s
letteri

memo 1

setup

pacer . start 3 8 l

<]

But what if there were too many filenames to fit in one CommandShell window, so that
the filenames at the top of the list scroll off the top of the window? You might want to
avoid having to use the scroll bar to scroll back to the top of the list. Instead, you can
break the list into columns so that more of the filenames can fit on one screen.

You can do this with the -c option (which stands for columns; note that this is an
uppercase C). Whenever you type an option in the command line it is preceded by a
dash (sometimes called a minus); in conversation, the -c option is called minus C.
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Important Since UNIX is case sensitive, be sure that you do not use a lowercase c for
the -c option. Some options call for lowercase characters and some call for uppercase
characters.

To list the contents of the / directory in columns, follow these steps:
Enter cd / tomove tothe / directory.

Enter 1s -c onthe command line in the CommandShell window.

Be sure that you leave a space between the command and the option (that is, between
the 1s andthe -c).

The screen displays the output, which looks like the following.

pacer.start 4 8 Is -C /

Besktop dev mac root users
Desktop Folder etc mnt shlib usr
FILES lib newuni x tmp

bin lost+found nextunix unix

Enter cd

If you are logged inas start, the start directory is your home directory, so you need
only enter cd to return to it. If you have a different login name, enter
cd/users/start toreturntothe start directory.

If you want to know how large a file is, who owns it, or other technical information
about the file, you can use the 1s command with the -1 option (note that this /is a
lowercase ell) for a long listing.

Enter 1s -1 onthe command line.

Be sure to type a space between the 1s commandandthe -1 (lowercase ell) option.
The output is shown below.

pacer.start 6 8 Is -|

total 8

SnuErsSR=s 1 start project 1289 Jan 1?7 1998 letteri
—rW-r-—pr-— 1 start project 884 Jan 17 1996 memol
—PUXP=XP—X 1 start project 94 May 12 1989 setup
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The first three columns give permissions and ownership information. The next three
columns tell the size (in bytes), the date on which the file was last changed, and the
filename.

Arguments

Technically speaking, an argument is any item on the command line that modifies the
way the command works. This guide, however, uses the word argument as it is
commonly used, to mean the file or other object upon which the command acts. Some
commands must have an argument, whereas others (such as 1s) might or might not
require an argument, and others (such as pwa) rarely or never take an argument.

Using the 1s command with an argument

If youare working in the start directory and you want to display a list of the
contents of the / directory, you would use the 1s command with the name of the
root directory (designated by the / character) as the argument.

Enter 1s / onthe command line.
Note the space between the command and its argument.
A listing of the contents of the root directory appears on your screen.

You also can list a single file by using its name as the argument. For example:

Enter 1s -1 letterl on the command line.

A single line appears that gives you the long listing for the file 1etter1, butforno
other files in the directory.
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The Commando dialog box

Many UNIX commands have a large selection of options and require learning a complex
syntax for entering these options on the command line. To make it easier for users to
learn and to remember the various tasks that a given command can perform, and to
simplify and to automate entering the command on the command line, A/UX contains an
application called Commando.

UNIX commands vary in the options they offer; therefore, Commando dialog boxes
vary considerably from one another. However, most Commando dialog boxes have the
same basic elements as Macintosh OS dialog boxes: radio buttons, check boxes, text
boxes, and file buttons. In addition, all Commando dialog boxes have a Help box,
Output and Error pop-up menus, and standard buttons, such as Cancel. Figure 4-1 shows
an example of the elements of a Commando dialog box.

—grep Options
~Required
: Search pattern:

I

~Dperation
@ List matching lines

Q List non-matching lines
i QO List files names only

( Files to search ) L] Count lines
Output Error [ Ignore case
| I ] [JPrint line number(s)

[JPrint block number(s)
[JSuppress errors

—Command Line
grep

—Help— - s Cancel
Search a file for a pattern. ‘grep' search patterns are limited reqular

expressions in the style of ed. It uses a compact nondeterministic ﬁ are n
algorithm to search the fite. §rep

Figure 4-1 Elements of a Commando dialog box

Using Commando

There are three ways to display a Commando dialog box while using CommandShell:
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s Type the name of the command and choose Commando in the CommandShell Edit
menu. For example, type 1s on the command line, then choose Commando in the

Edit menu.

»  Type the name of the command, then press CommanD-K. For example, type 1s on
the command line, then press CoMmanD-K

= Enter cmdo followed by a space; then type the name of the command whose

dialog box you want to use. For example, enter cmdo 1s on the command line.

Warning The last method of invoking Commando is not supported in 24-bit addressing
mode. For further information on 24-bit and 32-bit addressing mode, see “Changing Your

Session Type” in Chapter 8, “Customizing Your Work Environment.” A

You can see how useful Commando is by working with a command that is already
somewhat familiar to you, the 1s command.

With the CommandShell window displayed, type 1s (do not press RETURN).

Either select Commando from the Edit menu or press CommanD-K.

The Commando dialog box for the 1s command appears.

~Is Options

[ Choose directories/files

)

~-Mark file types -
@® No marking

O Mark directories
O Mark other types

[ List all files
[ Show size in blocks
[J Show i-node numbers

--Show more information -y

@ Short format, one column
O sorted vertically

(O sorted horizontally

QO Long format

(O show ID numbers

O no group information

O no owner information

(More options | [0utput & Error]

—Comr d Line
£

—Help

listed.

List the contents of a directory and/or display information about the files

Ii Is I

Using Commando
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The Help box

Commando can serve as a quick command reference. At the bottom of every Commando
dialog box you see a box labeled Help. This box contains a brief description of the
command or the selected option.

Look at the Help box at the bottom of the dialog box.

This gives you a quick summary of the main functions of the command.

Use your mouse to point to the button labeled “Choose directories/files” and
hold down the mouse button.

Information relative to your selection appears in the Help box.

Without releasing the mouse button, move the pointer away from the “Choose
directories/files” button, then release the mouse button.

Perform Step 2 with several of the radio buttons and check boxes to view the
various explanations in the Help box.

If you happen to activate any of the radio buttons or check boxes, click them again to
deactivate them.

The Command Line box

Commandois a command-line building tool. This means that the Commando dialog box
doesn't run the command directly; it creates the proper command line in the
CommandShell window. You can then run the command by pressing RETURN, or you can
alter it to suit your needs.

Justabove the Help box is the Command Line box. This box shows you the
command line that the Commando dialog box is building. As long as you haven't yet
chosen any options, only the command itself (1 s, in this case) appears in this box.
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Click the Command button labeled “Is” at the lower right of the dialog box.

The dialog box is replaced by the active CommandShell window, which contains the
command line you have constructed thus far. The 1s command, which was shown in
the Command Line box, is now displayed on the command line, ready to be run.

Redisplay the 1s Commando dialog box.

The 1s command is already on the command line. You need only press CoMmManD-K to
redisplay the dialog box, which you will use in the following exercise.

Choosing arguments

The “Arguments” section earlier in this chapter points out that you can apply the 1s
command to a specific file or directory by using the appropriate filename or directory
name as the argument to the 1s command. In the Commando dialog box, you do this
with the “Choose directories/files” button.

Click “Choose directories/files.”

The following dialog box appears.

(Add Current Directory: )

Sstart v : Current directory

0O letter1

0 memol
0 setup fjeqd
O ecshrc

D eExamplsBackUp
D ekshrc

D elogin

DO elogout

) emac Cancel

Desktop

Select files and/or directories:

2
[ Add |
5| Chomave )

This dialog box allows you to specify one or more files and directories as arguments.
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The name of the current directory is displayed in a small box just below the Add
Current Directory button, as shown previously. When you click this box, a pop-up menu
appears that lists all the directories above the current directory on the directory tree.

To list all files in both the / directory and the /users directory, do the following;

1 Thecurrent directory, which is listed at the top of the dialog box, is start.
Select it and hold down the mouse button; then select Desktop from the pop-up
menu.

The newly displayed menu lists the items on the desktop. If you are logged in to the start
account, the start aliasfolder is on your desktop and is therefore listed in this menu. If
you have inserted a floppy disk, that too is shown in the menu.

2 Double click the / directory icon (highlighted in the dialog box shown below)
to make the / directory the current directory.

(Add Current Directory:
|E Desktop ']

ats =/

O Extra Mac Disk =

= MacPartition

?f; ‘”6” olies feskiop

i frash
5

select files and/or directories:
ik _____

( Add ]

5

3 Click Add.

You have now put the root directory in the list of arguments.
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To add the directory named users, double-click the highlighted / directory
icon (just below the Desktop icon); then scroll down the list of files and
directories until users is displayed; then select users and click Add.

The arguments you are adding to the command appear in the “Select files and/or
directories” box at the bottom of the dialog box. as shown here.

Select files and/or directories:

7 <]
/users

]
Click Done.

When the Commando dialog box reappears, examine the Command Line box. You have
constructed the following command line:

ls / /users
This means, “List the contents of the / directory and the directory called users,
which isjust below the / directory in the directory tree.” For an explanation of

pathnames such as /users, see “UNIX Pathnames” in Chapter 2, “Using Files, Folders,
and Directories.”

Press RETURN.

The command line appears at the command prompt, ready to run.

Press RETURN to run the command.

Choosing options: radio buttons and check boxes

This exercise introduces more options of the 1s command and familiarizes you with
the use of check boxes, radio buttons, and the “More options” button.

You have already worked with two of the options that the 1s Commando dialog
box offers: the -c option (to divide the listing into columns) and the -1 option (to
create a long listing).
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These two options are contained in the “Listing style” section of the 1s Commando
dialog box, which is in the right half of the dialog box.

For the following exercise, display the 1s Commando dialog box again if it is not
already displayed.

Use your mouse to display the help message associated with the “Long format”
radio button (see “The Help Box” earlier in this chapter).

Observe that the Help box tells you that this radio button controls the -1 option and
briefly describes what the -1 optiondoes.

Examine the help message of the “sorted vertically” button (in the “Short
format” group of buttons).

Observe the change in the Help box, which now describes the -c option.

Click the “sorted vertically” button so that it is darkened, which means that it is
turned on.

As in standard Macintosh dialog boxes, only one radio button in the group of radio
buttons can be turned on at a time. The Command Line box now displays the following
line:

1s -C

Click the “Mark directories” button (located in the “Mark file types” section, at
the upper left of the dialog box).

Ordinarily, you cannot tell which item in the list is a filename and which is a directory
name. This option places a / symbol after directory names to differentiate them from
filenames. The -p option is now added to the Command-Line box.

Choose the “List all files” check box in the “Show more information” group.

This button forces the listing to contain all filenames, including those that begin with a
dot (), which are normally left out of the listing. As in standard Macintosh dialog boxes,
the difference between radio buttons and check boxes is that you can select any number
of check boxes in a given group at the same time but only one radio button within a
given group.
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Click “More options.”

A new dialog box appears, which offers you more options. Some Commando dialog
boxes contain several “More options” buttons to offer several levels of additional options.

Click the Cancel button of the “More options” dialog box to return to the main
Commando dialog box.

Click “Choose directories/files” to choose the / directory as the argument.

This is described in the tutorial in “Choosing Arguments,” earlier in this chapter.

Click the Done button of the “Choose directories/files” dialog box.
The Command Line box now shows that you have constructed the following command:

ls -a -C -p /

That is, “list (1s) allthe contents (-a) in multiple columns (-c), and placea / mark
after directory names (-p); do all this to the / directory only (/ argument).

Click Is (at the lower right of the dialog box).

The active CommandShell window appears with the command line ready to run.

Press RETURN to run the command.

The standard output of the command (that is, the results shown on the screen) is shown
below. There might be differences between this illustration and the files and directories
displayed on your screen, because as the system is used, some items are added or
deleted and others are moved to different places in the file hierarchy.

o/ Application lib/ start alias
7 Desktop Folder/ lost+found/ tmp/
.aux_prefs FILES mac/ unix

.eshre Guest alias mnht/ users/
-kshre TextEdi tor alias newunix usr/

.login bin/ nextunix

. logout dev/ root/

.mac/ ete/ shlib/

.profile

As you can see, for the occasional user of UNIX, the Commando command-building
tool offers a powerful and effective way of using UNIX commands.
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The following pages show you how to use several useful features of the UNIX operating
system. Some of these tutorials illustrate the use of more features of the Commando
dialog boxes.

Using a different user account after logging in

While you're working in one login account, you might want to accomplish some task in
a different login account without logging out of the system and logging in to the other
account. When you do this, you become a substitute user. For example, if you need to
perform a system-administration task, but you are currently working in a user account,
you can temporarily use the root account, perform the task, then return to your user
account without having to log out and log back in twice.

You can work in any account if you know its login name and password. Becoming a
substitute user does not log you out of your own account and in to a new account; it
merely allows you to work in the other account temporarily. As soon as you exit from
the other account, you are once again working in your original account.

You can become a substitute user only while working in a CommandShell window,
and you're a substitute user only as long as you are working in that window. When you
return to the Finder, you automatically return to your original user account.

In the active CommandShell window, enter the command su and a space, and
the login name of the new account.

For example, enter su root. A/UX displays the following prompt:

Password:

You need to know the password for the new account (the root account, in this case) to
complete this procedure.

Chapter 4 Using UNIX Commands and Commando



Type the password.

No characters are displayed as you type the password.

Press RETURN.

When you press RETURN, A/UX reads the password. If the login name and password are
correct, you can begin to work in the new account. If either the login name or the
password is incorrect, you see the following message:

su: Sorry

In this case, you are still working in the same account you were originally using.

When you return to the Finder (by clicking any Finder icon or open Finder window or
by choosing Finder in the Applications menu), you automatically return to your original
user account. You can end the substitute user session while still in CommandShell by
entering the command exit atthe command line.

Searching for a string of characters and
redirecting output

One useful UNIX command is called grep; it is used for finding a given string of
characters in any file you specify. For example, suppose that you need to glance at all
references to the word sales in the filesthat are in the start directory. For the
purposes of this tutorial, assume that the phrase is in either memol or letterl,
since they are the only pieces of business correspondence in that directory.

Instead of looking at the results of the search on screen, you can save the information
in a separate file so that you have it available for future reference. This requires
redirecting the output of the search to a file rather than displaying the results on a
screen.
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1 InacCommandshell window, type grep and press ComMaND-K to display the
grep Commando dialog box.

—grep Options
~Required : Operation
: Search pattern: . | @ List matching lines
|| ] : O List non-matching lines
! i 1 QO List files names only

( Files to search ) . [ Count lines

Output Error [ Ignore case
| [ ] [ Print line number(s)

O Print block number(s)
[ Suppress errors

—Command Line
grep

-Help— . = Cancel
Search a file for a pattern. ‘grep’ search patterns are limited regular

expressions in the style of ed. It uses a compact nondeterministic 70D
algorithm to search the file. ikt

There is a text box at the upper left of the dialog box. It is marked Required because you
cannot use the grep command without specifying the pattern of charactersfor which
you are searching.

2 In*“Search pattern,” type the characters you are looking for:

sales

Click “Files to search.”

4 Display the start directory’s files in the file list.

If some other directory is displayed at the top of the “Files to search” dialog box, and if
the start folder is on the Desktop, follow these steps:

»  Select the current directory name and hold the mouse button down.
= Choose Desktop from the pop-up menu.

= Choose the start directory from the new menu that appears.
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Ifthe start folder is not on the desktop, follow these steps:

= Return to the root directory by choosing / from the pop-up menu that appears when
you point to the current directory’s name and hold down the mouse button.

= Double-click the users directory, thenthe start directory, in the files list.

This causes the files in the start directory files to appear in the files list.

5 Choose the following files either by double-clicking their names or by selecting

a filename and choosing Add:

memol

letterl

The filenames (with their complete pathnames) appear in the “Select files” box. These
are the files the system will search through for the specified string of characters.

[D lettert [ =/

O eExamplsBackUp 2

0O ekshrc —_— — —

D siogin

DO elogout

O emac

Select files:

[/users/start/letter1 I ————
[ sldd |

6 Choose Done.

The grep Commando dialog box reappears.

7 Check “Ignore case” (the -i option).

The “Ignore case” option allows the search to succeed even if the characters are not all

lowercase (as you typed them in the text box).
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10
11

12

To redirect the output to a new file, select Output and hold the mouse button
down; then choose New File in the pop-up menu.

This displays a dialog box that allows you to enter the name of a new file in which to
save the results of the search.

Be sure thatthe start directory is displayed in the files list and type the
following filename in the “Redirect to” text box:

salessearch
The output of the search will be redirected to a new file named salessearch and
will be saved in that file.

Choose OK.

Choose the grep button.

You have built the following command line:

grep -1 sales /users/start/letterl /users/start/memol

>/users/start/salessearch

Table 4-1 explains the meaning of each item on the command line.

Table 4-1 Items in the command line of Step 11

Command-Line Item Meaning

grep search for a pattermn of characters

it ignore case

sales search for this pattern of characters
/users/start/letterl

/users/start /memol search through these files

> redirect to the following file
/users/start/salessearch create this file and send the results of the search to it

When the CommandShell window reappears with the complete command line,
press RETURN to run the command.
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To check the results, return to the Finder by clicking the start folder to make it the
active window or by choosing Finder in the Applications menu. Note that the start
folder now contains a file named salessearch.Ifthe start folder isnotopen,
double-click its icon to open it. Double-click the salessearch icon to open the text file.
This opens the TextEditor window that displays the text file. For information on
TextEditor, see Chapter 6, “Writing with TextEditor.”

E=—=————— /users/start/salessearch S—=====n|
fusers/start/letter1:Ue have instructed our New York sales office te remove the damaged [iF
/users/start/letter: Director of Sales
/users/start/memo1:70: Sales Representatives

/users/start/memo1:GO0D PRODUCTS and GOOD SUPPORT. Every salesperson who's been with

This shows you the file (with its full pathname) in which the characters occur and the
line on which they occur.

For a review of UNIX-style pathnames, see “UNIX Pathnames” in Chapter 2, “Using
Files, Folders, and Directories.”

Looking up UNIX commands on screen

If you need to look up information about a UNIX command, you can use the printed
version of the A/UX Command Reference (see “Command Reference Notation” in the
Preface of this guide). You also can display on your screen the complete text of the A/UX
Command Reference entry (called the manual page, or the man page)forany
command.

The term manual pagemight lead you to assume that each entry is only one page
long, but that is not the case. Some of these entries are dozens of pages long.
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Display a man page as follows:

Enter man commandname

Use the name of a command (for example, 1s) in place of commandname.
The text that appears on screen has somewhat simpler formatting than the text that

you read in the A/UX Command Reference. For example, terms that are in italic type in
the printed book are underlined on screen.

Follow these directions to examine the man pageforthe 1s command:
Enter the following on the command line:

man 1s

sS[=—————————— CommandShell 1

pacer.root # man Is

IsC1> Is<1)

NAME
Is - lists the contents of a directory

SYNOPSIS
Is [-al [-b]l [-el [-C] [-d] [-F] [-g] [-i] [-I] [-L] [-m]
[-n] [-0] [-p] [-q] [-r] [-R1 [-s] [-t] [-ul [-x] [names]

ARGUMENTS
-a Lists all entries. Usually entries whose names begin
with a period (. > are not listed.

-b Forces printing of nongraphic characters to be in the
octal \ddd notation.

-¢  Uses the time of the last modification of the i-node
(file created, mode changed, and so forth) for sorting
(-t> or printing {-1).

-C Specifies multicolumn output with entries sorted verti-

Moving down through the man display

You can show the next screen of text or advance line by line as follows:
Press the space bar to display the next screen of text.

Press Return to advance the text one line at a time.
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To review material that has been scrolled off the top of the screen, use the scroll bar.

The “Name” section

The man page begins with the “Name” heading, which introduces a brief summary of
what the command does:

ls - list contents of directory

This is the text that appears in the Help box of the Commando dialog box.

The “Synopsis” section

The “Synopsis” section appears below the “Name” section. It looks rather mysterious at
first view, but it becomes clearer once you know what to look for. The 1s synopsis
reads as follows:
SYNOPSIS
ls [-R] [-a] [-d4] [(-C] [-x]) [-m] [-1] [-L] [-n] [-o] [-g]
(-r] [-t] (-u) [-c] [-p] [-F] [-b] [-q] [-i] [-s] I[names]

Don't be discouraged by the long list of bracketed items. The synopsis summarizes
the way the 1s command is used on the command line. It will look clearer if you
consider its separate components one at a time.

ls You begin by typing the 1s command itself.

[-R] ... [-s] These are the options. You continue by typing any of the
bracketed options that are appropriate.

Note that you do not type the brackets on the command line. The
brackets are a conventional way of indicating that the bracketed
item is optional.

Asyou learned earlier in this chapter (see “Options and
Arguments”), you can use the 1s command without any options.

[names] Finally, you type the argument, if necessary. The fact that it is
bracketed indicates that it, too, is optional. In this case, names
refers to names of directories or files.
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The “Arguments” section

This is essentially a list of all the options and arguments. Note that options and
arguments are listed together, in one section, and are arranged alphabetically. Some of
the items in the list of 1s command options are familiar to you. Here are two
examples:

- Multicolumn output with entries sorted vertically.

-p Put a slash (/) after each filename if that file is a

directory.

Some of the explanations might be expressed in technical language that is a bit
obscure. For an alternate explanation, display the Commando dialog box and look at the
Help message for the item that you need to learn about. See “The Help Box” in “